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ASG Support Numbers

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during normal
business hours and emergency support during non-business hours. To expedite response time,
please follow these procedures.

Please have this information ready:

. Product name, version number, and release number
J List of any fixes currently applied
. Any alphanumeric error codes or messages written precisely or displayed

. A description of the specific steps that immediately preceded the problem

o The severity code (ASG Support uses an escalated severity system to prioritize service to
our clients. The severity codes and their meanings are listed below.)

. Verify whether you received an ASG Service Pack for this product. It may include
information to help you resolve questions regarding installation of this ASG product. The
Service Pack instructions are in a text file on the distribution media included with the
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem.

2 Leave a detailed message including your name and phone number. A Support representative
will be paged and will return your call as soon as possible.

3 Please have the information described above ready for when you are contacted by the Support
representative.

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response
Time
1 Production down, Within 30 minutes

critical situation
2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours
work-around solution

4 "How-to" questions and enhancement Within 4 hours
requests

ASG provides software products that run in a number of third-party vendor environments. Support
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor
discontinues support for a hardware and/or software product, ASG cannot be held responsible for
problems arising from the use of that unsupported version.



Business Hours Support

Your Location

Phone

Fax

E-mail

United States and
Canada

Australia
England
France
Germany

Singapore

All other countries:

800.354.3578

61.2.9460.0411
44.1727.736305
33.141.028590
49.89.45716.300
65.332.2922

1.941.435.2200

941.263.2883

61.2.9460.0280
44.1727.812018
33.141.028589
49.89.45716.400
65.337.7228

Non-Business Hours - Emergency Support

Your Location

Phone

Your Location

support@asg.com

support.au@asg.com
support.uk@asg.com
support.fr@asg.com

support.de@asg.com

support.sg@asg.com

support@asg.com

Phone

United States and
Canada

Asia
Australia
Denmark
France
Germany
Hong Kong
Ireland
Israel/Bezeq
Japan/IDC

800.354.3578

65.332.2922
0011.800.9932.5536
00.800.9932.5536
00.800.3354.3578
00.800.3354.3578
001.800.9932.5536
00.800.9932.5536
014.800.9932.5536
0061.800.9932.5536

Japan/Telecom
Netherlands
New Zealand
Singapore
South Korea
Sweden/Telia
Switzerland
Thailand

United Kingdom

All other countries

0041.800.9932.5536
00.800.3354.3578
00.800.9932.5536
001.800.3354.3578
001.800.9932.5536
009.800.9932.5536
00.800.9932.5536
001.800.9932.5536
00.800.3354.3578

1.941.435.2200



ASG Web Site

Visit http://www.asg.com, ASG’s World Wide Web site.

Submit all product and documentation suggestions to ASG’s product management team at
http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at (941)
263-3692. Please include your name, company, work phone, e-mail ID, and the name of the ASG
product you are using. For documentation suggestions include the publication number located on
the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp
http://www.asg.com
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Preface

This ASG-Encore Installation Guide explains the installation and maintenance of
ASG-Encore (herein called Encore). Encore is a powerful interactive system that helps
analysts and programmers to re-engineer, redevelop, or maintain existing COBOL
systems.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical

support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

) Chapter 1, "Introduction," contains an overview of product installation,
re-engineering analysis, code extraction analysis, target generation, and operating
environments.

. Chapter 2, "Customization," describes the customization of specific Encore
components, invoking Encore, and validating the Encore installation.

il
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Related Publications

v

The documentation library for ASG-Encore consists of these publications (where nn
represents the product version number):

J ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by
most ASG-Existing Systems Workbench mainframe products. ASG-Center must be
installed before installing ASG-Encore.

o ASG-Encore Installation Guide (ENX0300-nn) explains the installation and
maintenance of ASG-Encore.

o  ASG-Encore Reference Guide (ENX0400-nn) provides detailed information about
the pop-ups, screens, and commands used in ASG-Encore.

o ASG-Encore User’s Guide (ENX0200-nn) provides user information about
ASG-Encore.

Note:
To obtain a specific version of a publication, contact the ASG Service Desk.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

HI ASG-Insight for Program Understanding |

%I ASG-Estimate for Resource Estimation |

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
-TSO
- CICs

ASG-Center - IMS

- ASM

- APS

- PLI

-TCA

- DB2 Stored Procedure

N H ASG-SmartDoc for Program Documentation |
Application

Knowledge
Repository (AKR)

H| ASG-Recap for Portfolio Analysis |

H| ASG-Alliance for Application Understanding |

%| ASG-Encore |

HI ASG-AutoChange |

HI ASG-Bridge |
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vi

This table contains the name and description of each ESW component:

ASG-Alliance

Alliance

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange

AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.
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ASG-Encore

Encore

The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate

Estimate

The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight

Insight

The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap

Recap

The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc

SmartDoc

The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

vii
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

viii

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page ix for more information about
using ESW.
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance AL Understand » Application
AutoChange CC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Re-engineer) EN Re-engineer P Program
Estimate ES Measure P ASG-Estimate
Insight (Understand) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Document) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartTest ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly or through the main ESW screen. As a result, you might see different
fields, values, action bar options, and pull-down options on a screen or pop-up depending
on how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed. Access to these integrated products requires only that they be installed and
executed in the same libraries.

X
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Examples

Example 1. Figure 2 shows the Encore Primary screen that displays when you access
Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew EHtract Generate 2earch List Options Help

REG-Encore
CoMRand ===
etk Eas s L S e Aotttk
Atk Boos s I e etk
A=tetoiek A=tetoiek Aebetstebek deboletck etk
Aettotk Aettotk dettsictsk destotetek etk
Hetstsick
Atttk

Copwright Allen Systens Group, Inc., an unpublished wark.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Visit the ASE Support Web Site at wuM.asq.coH

Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 « ESW Encore Primary Screen

File Wiew Extract oGenerate Search Logic List Options Help

AZE-EIN - Prograd Re-engineering

CoMHand ===
etttk Hebbtt bbbk Aottt
Aetetotek detstetek etk Aetetetek:
Aotk Aotk Hebebbtk bbbk etk
ettt ettt debebbtk bbbk Hdk
Atttk
Aotttk

copyright Allen $ystens Group, IncC., an unpublizhed vork.
A proprietary product of ASG, Inc. Use restricted to authorized 1icensess.
Visit the ASE SUpport Web Zite at wuw.asg.cod
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Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays
when you access SmartTest through ESW.

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4. This field is automatically customized to contain the ESW products
you have installed on your system.

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc
Options) is available on the File - Analyze Submit screen if the SmartDoc product is
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 « File - Analyze Submit Screen

File - Analyze SUbHiT
CorAdand ===

E - Edit JCL 2 - EUbHIit JCL

CoMpile and link JoL (PDE or sequential):
Data set nane 'USER1Z2.REL.CGHNTL{VIAPCOBC)

Analyze features [v-M]i
REG—EMartTests ¥ Extended Analy=isl M

AKR data set naHe 'USER1Z2, GEMERAL.AKR'
AER prograd nade [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [Y<H] « v o« v o o o o i) [¥ if needad by features)
Link load Hodule reusable® [Y-M] Y

Figure S« File - Analyze Submit Screen (Accessed through ESW)

File - Analyze ZubHit
CoHHand ===

E - Edit JCL ¥ - EubRit TJCL 0 — AEG-EHartDoc Options

Codpile and link JCL [PDE or sequentiall:
Data set naWe 'UEER1Z.REL.CNTLIHTEST)

Analyze features [YoN)2
AEG-Insights Y ASG-SRartTest: §  Edtended Analwsisi W
AEG-ERarthoc: N AEG-Encores N

AKR data zet naWe 'UEER1Z.GEMERAL.AKR'

AKR prograd nare [if owerriding PROGRAA-IO0)

Analyze options:

Codpile® [Y«M] o o o o & o« o & iy [¥ if needed by features)
Link 1oad Hodule reusable? (YoMl ¥ [ASG-EHartTest

X1
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Publication Conventions

Xii

ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
f1ilename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YN).



Introduction

This chapter describes Encore product installation, re-engineering analysis, code
extraction analysis, target generation, and operating environments, and contains these

sections:

Section Page
ASG Service Pack 1
Encore Overview 2
Operating Environment 5

Note:

Center installation and customization must be performed before installing Encore. If
Center has not been installed, see the ASG-Center Installation Guide at this time.

ASG Service Pack

Verify whether you received an ASG Service Pack for this product. If so, read the
instructions for installing the Service Pack before proceeding with the product
installation. The installation instructions are located in the text file on the distribution
media included with the Service Pack. If you have any problems with the Service Pack,
contact the ASG Service Desk.
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Encore Overview

Encore is the ESW re-engineering product for COBOL applications and includes these
features:

o Analysis facilities that allow you to extract code based on the most frequently used
re-engineering criteria.

) Code generation facilities that allow you to use the results of the analysis extract to
generate a standalone program, a callable module, and a complement module. Prior

to code generation, you can view and modify the extracted logic segment using the
COBOL editor.

Encore is designed to support these functions:
. Web enablement

o Open interface

J Platform and technology migration

o Re-implementation of business functions
o Component-based maintenance

Encore contains a Common User Access (CUA) interface with action bars, pull-down
menus, and pop-up screens that make it easy to learn and use.

Encore Components

Encore is comprised of these four functional components:
. Re-engineering analysis

. Code extraction

o Migration

e  Target generation



1 Introduction

Re-engineering Analysis Overview

Encore’s re-engineering analysis displays the source code in various levels. The
re-engineering analysis component consists of these three displays:

View Methods Contents of Views

Structure Displays the hierarchical relationships within the program in a
graphical mode. You can zoom in on the actual COBOL source
represented by the graphical display.

Tree Displays the program in logical execution order. This view allows
straightforward analysis of how the program works.

Source Displays the program in source code order and offers
COBOL-intelligent browsing capabilities.

The main purpose of re-engineering analysis is to gather enough information about the
program to make the best decision regarding code isolation and extraction.
Re-engineering analysis is available through the View facility.

Extract Overview

Encore’s main focus is the Extract facility, which addresses the re-engineering aspects of
code renewal, and provides the capability to isolate and extract logical code segments
from existing programs. These are the eight methods you can use to isolate and extract
code:

Objective Type  Purpose

Perform Range  Isolates and extracts a specific named PERFORMed range of code
within the COBOL program.

Transaction Isolates and extracts all code required for a specific transaction (i.e.,
all code between a start point and multiple end points that is, or
could be, executed based on the values of a data variable).

Computation Isolates and extracts all code that calculates a specific data variable

Variable from the beginning of the program to a specific statement in the
program.

Report Isolates and extracts all code necessary to produce a set of identified

output (WRITE) statements.

Statement Isolates and extracts a user-selected set of COBOL source
statements.
Complement Extracts the original program, excluding statements from a

previous extract.
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Objective Type  Purpose

Common Code  Identifies code common to two or more previous extracts.

CICS Server Isolates and extracts all code required to generate a CICS server

program.

See the ASG-Encore User’s Guide for more details about the Extract facility.

Migration

The most basic feature of Encore is to convert an existing MVS COBOL application to a
component-based architecture. Encore provides these capabilities for migration:

Clear separation of user interface and data access code from the business logic.

Removal of redundant logic.

Target Generation Overview

Target Generation addresses the disposition of the segment created in the Code
Extraction phase. For Target Generation, Encore provides these capabilities:

Separate program generation.
Callable module generation.

Complement module generation consisting of the original program with the
extracted Logic Segment removed.

10 module generation containing all input/output functions for an FD (File
Description).

Logical COBOL segment access with an editor, such as ISPF Edit or SmartEdit for
modification and customization.

Knowledge retention that helps with everyday maintenance tasks or major system
rewrites.

Logic Segment extraction used for input to CASE tools.

The Target Generation environment is a powerful lever against change. When business
needs call for enhancements to a specific function, only one Logic Segment is impacted,
dramatically reducing the time required for analysis and change.



Operating Environment

1 Introduction

This section describes the platforms on which Encore runs and the hardware and software
requirements for running the application.

Environment

Encore products have these requirements:

Platform Software

Host °

MVS/XA, MVS/ESA, or OS/390

MVS ISPF Version 3.5 thru 4.8 (3.1 is the minimum
supported release level, Estimate requires ISPF 3.3
(minimum supported release level))

BATCH region size of 4096 KB or larger

TSO logon region size of 2048 KB or larger below 16 MB
Direct Access storage

3270 type terminals; Models 2, 3, 4, or 5

VSAM (required if any AKR is allocated as VSAM)

Clients Windows 95/98/2000 or Windows NT with access to MVS

Servers 0S/390

COBOL Compilers

ESW products support these COBOL compilers:

Product COBOL Compiler

Compiler + COBOLD,E, and F
+ COBOLII
+  COBOL/370
+  COBOL for MVS and VM
+ COBOL for 0OS/390 and VM
Note:

Object oriented extensions added to COBOL for MVS and VM, and to COBOL for
0S/390 and VM are not supported.
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Preprocessor Support

Encore supports these preprocessor languages directly:

Product Language

Processor ° Command-level CICS

. Command-level DL/I

. IDMS

. SQL
Note:
Other preprocessed languages are not recognized, but can be supported from the
generated COBOL code.




Customization

This chapter describes customizing specific Encore components, invoking Encore, and
validating Encore installation, and contains these sections:

Section Page
Prerequisite 7
Step 1 - Modifying CNTL Library Members 8
Step 2 - Adding Encore Modules to MLPA/PLPA 10
Step 3 - Customizing Panvalet or Librarian 11
Step 4 - Customizing the Module Header Box 13
Step 5 - Setting up the Encore/COBOL/SF Interface 13
Step 6 - Invoking Encore 14
Step 7 - Validating Encore 15
Prerequisite

Center installation and customization must be performed before customizing Encore.

Note:

If Center has not been installed, see the ASG-Center Installation Guide before attempting
to install or customize Encore.
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Step 1 - Modifying CNTL Library Members

Use these CNTL library members to compile and analyze Encore demonstration
programs. Modify these members to specify a valid JOB card and correct parameter
values, but do not execute them at this time:

Member Description

VIAACMPI1

JCL to compile the ASG VIARDEMO demonstration program.

VIAACMP2

JCL to compile the ASG VIARDRIV and VIARSUBR
demonstration programs.

VIAACMP3

JCL to compile the ASG VIARANOM demonstration program.

VIAACMP4

JCL to compile the ASG VIARBRWS demonstration program.

Specify the correct values for these parameters:

Parameter Description

VIASOFT

Specify the high-level node where the ESW products are installed.

CENTER

Specify the second-level node where ESW products are installed. If
the ESW dataset names contain more than three nodes, then specify
all nodes except the first and the last as CENTER. For example, the
dataset name SYS3.CENxx.NEW.LOADLIB should have
VIASOFT=SYS3 and CENTER=CENxx.NEW.

SYSOUT

Specify the correct SYSOUT character.

SYSDA

Specify the appropriate UNIT for temporary datasets.

COMPILR

Specify the COBOL compiler load module name. It currently
defaults to the COBOL II compiler.

COBCOMP

Specify the COBOL compiler load library name. It currently
defaults to the COBOL II library name.
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Specify the correct values for these VIAACMP3 and VIAACMP4 CNTL library member
parameters:

Parameter Description

CICS Specify the high-level node(s) where the CICS Command
Translator/Preprocessor has been installed.

CICSCOB Specify the low-level node where the CICS Command
Translator/Preprocessor copybooks have been installed.

CICSLIB Specify the low-level node where the CICS Command
Translator/Preprocessor load library has been installed.

CICSTRAN Specify the CICS Command Translator/Preprocessor load module
name.

TRNPARM Specify the CICS Command Translator/Preprocessor parameters
that are required by your facility.

To override the default Encore installation options

Perform this action only to override Encore default installation options.
. Edit the ASG.VIACENxx.CNTL member VIASPRMA and modify these options.
— COBOLSF
—  Gen-COBOL-Last-Node=COBOL
— NETRON
—  Export

See the Installation Option appendix in the 4ASG-Center Installation Guide for
information about changing the installation option values.
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Step 2 - Adding Encore Modules to MLPA/PLPA

10

These are the Encore load modules that can be added to the Modified Link Pack Area
(MLPA) or Pageable Link Pack Area (PLPA), which are re-entrant and linked
AMODE(31), RMODE(ANY).

ASG Module Additions to MPLA/PLPA

VIAENC VIARCMMP VIARCSFI VIARCSFM

VIARISPP VIARICSF VIARCSOM VIARWKSP

VIAZBTCH VIAZCMDP VIAZGENP VIAZPRIP

VIAZTBLP

For the names of all the modules that are eligible for location in the MLPA or PLPA, see
the installation guide for the other ESW products you have installed.

These are some advantages to locating modules in the MLPA or PLPA:
o A reduction of the memory requirement per user
o An overall decrease in required swap space

) Performance improvements

Moving these modules to MLPA/PLPA is optional. It is recommended that the original
ESW load library (from the installation tape) be kept as a staging library so that you can
apply any required PTFs. You can copy the re-entrant modules to LPA and the
non-re-entrant modules to a separate user library. These steps also require changes to the
user's logon or product allocations. The CNTL library contains two members, VIASLPAJ
and VIASLPXJ, which can be used to perform these steps.

Note:

Do not use the ISPF 3.3 copy feature to copy these modules because some of them have
aliases.




2 Customization

Step 3 - Customizing Panvalet or Librarian

Panvalet Customization

To customize Panvalet

Note:

Do not perform step 1 if you are using Panvalet R12 and the module PAM is available in
LINKLST or LPA.

1 Edit CNTL member VIASPAMJ and specify a valid JOB card and the correct values
for these parameters:

ASMBLR
PANLIB
SYSOUT
SYSDA
VIASOFT
CENTER

2 Submit this job to assemble and link edit the Panvalet VIASPAM module.

If Panvalet requires changes to its customized edit panel, these changes may need to be
included in the ESW panel VSPEDPAN. If this situation occurs, contact the ASG Service
Desk for instructions.

If the Panvalet load library is allocated under ISPLLIB and the LIBDEF facility is used,
WTP MEMBER NOT FOUND warning messages display each time you select a Panvalet
member. Try these alternatives to correct the problem:

o Adding Encore allocations to LOGON and bypassing LIBDEF processing.

J Adding the Panvalet load library allocation to VIALLIB in LIBDEF processing.
o Setting WTPMSG OFF (not recommended).

11



ASG-Encore Installation Guide

Librarian Customization
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To customize Librarian

1 Edit CNTL member VIASFAIJ and specify a valid JOB card and the correct values
for these parameters:

ASMBLR
LIBRLIB
LIBRMAC
SYSOUT
SYSDA
VIASOFT
CENTER

If you are running on Librarian R3.9, edit CNTL member VIASFAIR and comment
out the four lines containing these delete statements:

DELETE EPLOC=XFAIROPN
DELETE EPLOC=XFAIRMOD
DELETE EPLOC=XFAIRREC
DELETE EPLOC=XFAIRCLS

2 Submit this job to assemble and link edit the Librarian VIASFAIR module.

If Librarian requires changes to its customized edit panel, these changes may need to be
included in the ESW panel VSPEDLIB. If this situation occurs, contact the ASG Service
Desk for instructions.

If the Librarian load library is allocated under ISPLLIB and the LIBDEF facility is not
used, WTP MEMBER NOT FOUND warning messages display each time you select a
Librarian member. Try these alternatives to correct the problem:

J Adding Encore allocations to LOGON and bypassing LIBDEF processing.

J Adding the Librarian load library allocation to VIALLIB in LIBDEF processing.
o Setting WTPMSG OFF (not recommended).
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Step 4 - Customizing the Module Header Box

When a module is generated, a header box is placed at the beginning of the source code.
You can modify the template for the header box to conform to site standards.

To modify the header box template

» Edit CNTL member VIARCBSK. All text in the member can be edited except for the
symbolic parameters (i.e., parameters that begin with &).

Step 5 - Setting up the Encore/COBOL/SF Interface

To interface between Encore and COBOL/SF
1 Edit CNTL member VIASPRMA and add COBOLSF=YES.
2  Edit CNTL member VIARCSFP. This member specifies the dataset name

allocations to be performed when COBOL/SF is invoked during the ANALYZE
process.

a  Verify, and change if necessary, the high-level node for the COBOL/SF
libraries. The default is ECF.V2R2M1.

b  Specify a VOLSER for the SSQTEXT VSAM dataset. The default is question
marks.

3  Edit CLIST member VIAACSE. Verify, and change if necessary, the high-level node
for the COBOL/SF libraries. The default is ECF.V2R2M1.

4  Ensure that ECF.V2R2M1.SECFEXCO is included in SYSPROC allocation. This is
described in the Host Installation section of the Program Directory for COBOL/SF.

13
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Step 6 - Invoking Encore

To invoke Encore from an ISPF panel

Use these panel definition cards to add an Encore option to the ISPF primary menu or
another dialog menu.

e  This entry describes the Encore option to the user:

% EN +ASG Encore - COBOL re-engineering Environment

o This entry invokes Encore when the letters EN are entered:
EN, ’CMD (%ENCORE) NEWAPPL (VIAR) '

Note:

After updating the ISPF environment you may need to re-enter ISPF before the facilities
become available.

To invoke Encore using a CLIST

14

Use either of these methods to invoke Encore using a CLIST:

J Type TSO VIAENC on the command line in the ESW Primary screen. The
VIAENC CLIST invokes the ENCORE CLIST while specifying the
NEWAPPL(VIAR) parameter to set the correct application ID.

J Type EN on the command line in the ESW Primary screen. The EN CLIST
automatically invokes a pre-defined ENCORE CLIST.



2 Customization

Step 7 - Validating Encore

Note:

The dataset names used in the following validation steps are the default installation
names. If you have changed them, use the changed names in place of the default names.

To verify logon library allocations
1 Enter Encore by selecting the correct option from the appropriate menu.

Note:

If you installed Encore as indicated in "Step 6 - Invoking Encore" on page 14 use
the appropriate selection on the ISPF menu or the CLIST.

2 Select Help » About to display the Help - About pop-up, as shown in Figure 1.

This pop-up displays the product release and level of Encore that has been installed.
It also contains the product name, product release number, product maintenance
level, and the operation system.

Figure 1« Help - About Pop-up

File WView Extract Generate Search List Options Help

Help - About ogram: VIARBEWS
C

The following is release information for this A3G

| |

| |

| |

| product. | FEFEEFEETTETE
| | FTEEFTEATLES
| Product nawe . . . . . . . @ AZG-Encore

| Release number . . . . . I ¥.X

| Maintenance lewvel . . . . @ XXX | FEEEEEE

| | FTEEETEES

| ASG-CENTER release number @ X.X | wEE

| Maintenance lewvel . . . . @ XXX | TEE

| | TEEEL

| Operating system . . . . . @ O3(390) | FEEF

| |

! !

Copyright Allen 3ystems Group, Inc., an unpublished work.
A proprietary product of A3G, Inc. Use restricted to authorized licensees.
Visit the ASG Support Webh Site at www.asg.com

3 Press PF3/15 to exit the Help - About pop-up.

4  Review and/or modify Encore options by selecting the Options pull-down from the
action bar.

15
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a  Select Options » Product Parameters to display the Options - Product
Parameters pop-up, as shown in Figure 2. Review and/or modify the parameter
definitions and press PF3/15 to exit.

Figure 2 « Options - Product Parameters Pop-up

File View Extract Generate Search List Options Help

Options - Product Parameters

Command ===}
Type desired product parameters. Then press
3K KK K K KK K K Enter.
K KKK K K KR KK
AR KKK Cursor Substitution Character %
KKK KK

KK KK K KKK KK 3K 3K K K COBOL Module Exit
KKK KK KKK K K KR KK

XEEKK Options Default View
KKK K * _ Alarm 4 1. Structure View
KKK KK *k _ Confirm on Exit 2. Tree View
KA KK KKK _ Save EQUATES 3. Source Yiew
Save EDIT File 4. None

Copyright Allen '=-=-------------omm oo oo oo oo o mmmmmm o m oo
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

b  Select Options P Product Allocations to display the Options - Product
Allocations pop-up, as shown in Figure 3. Review and/or modify the
allocations and press PF3/15 to exit.

Figure 3 « Options - Product Allocations Pop-up

File View Extract Generate Search List Options Help

Options - Product Allocations
c Command ===> _
Log file:
Generic unit . . . SYSDA (generic group name or unit address)
Volume serial . . (blank for authorized default volume)
List file:
Generic unit . . . SYSDA (generic group name or unit address)
Volume serial . . [blank for authorized default volume)
Punch file:
Generic unit . . . SYSDA [generic group name or unit address)
Yolume serial . . [(blank for authorized default volume)
Work file:
Generic unit . . . SYSDA (generic group name or unit address)
Yolume serial . . [(blank for authorized default volume)
Space units . . . CYLS [BLKS, TRKS or CYLS)
Primary space . . 5 (space units)
Secondary space 5 [space units)
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¢ Select Options » Log/list/punch to display the Options - Log/List/Punch
Definition pop-up, as shown in Figure 4. Review and/or modify the log, list,
and punch file defaults. Enter the Job statement information and press PF3/15
to exit.

Figure 4 « Options - Log/List/Punch Definition Pop-up

Options - Log/List/Punch Definition
Command ===>

1 - Process log file 2 - Process list file 3 - Process punch file
4 - Customized data set name

Options Log List Punch
Process option . . . . . . PD PK K
Primary tracks A | 1 1
Secondary tracks L. 2 5 5
Lines per page . . . . . . 5B 56 56
Sysout class . . . . . . . % X x

Process options: PK (print/keep), PD (print/delete), K, or D.

Job statement information
//NAME JOB (ACCOUNT], ' (NAME) *,

/7 MSGCLASS=A
/7% INSERT ' /xROUTE PRINT NODE.USER" HERE IF NEEDED.
/7%

d Select Options » PF keys to display the Options - PF Key Definition pop-up,
as shown in Figure 5. Review and/or modify the PF key definitions (press
Enter to switch between PF keys 1-12 and 13-24). Press PF3/15 to exit.

Figure 5« Options - PF Key Definition Pop-up

File View Extract Generate Search List Options Help

Options - PF Key (01-12) Definition RUWS
c Command ===3

Press Enter to process changes and/or to display alternate keys.
Press PF3/15 (END) to exit.

Number of PF keys: 24 Terminal type: 3278

PFO1 HELP
PFO2 SPLIT
PFO3 END
PFO4 ZOOMIN
PFO5 RFIND
PFOB FX %
PFO?7 UP
PFO8 DOWN
PFO9 SWAP S.
PF10 LEFT
PF11 RIGHT
PF12 RECALL
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To allocate an AKR

1 Select File » AKR Utility to display the File - AKR Utility pop-up, as shown in
Figure 6.
Note:

If you have already created an AKR when validating another ESW product, proceed
to the section "To analyze the demonstration program" on page 20 .

Figure 6  File - AKR Utility Pop-up

File View Extract Generate Search List Options Help

File - AKR Utility Program: VIARBRWS RWS
Command ===> _
Blank - Display member list D - Delete member
A - Allocate/expand AKR R - Rename member

Application Knowledge Repository [(AKR):

Data set name . . 'USER.TEST.AKR'

Member . . . . . (if "R" or "D" selected)
New name . . . . (if "R" selected)

Volume serial . . (if not cataloged]
Password . . . . [if passuword protected)

A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

2  Complete the File - AKR Utility pop-up by typing the name of an AKR to be
allocated. Type an A on the command line and press Enter to display the
File - AKR Allocation/Expand pop-up (see Figure 7 on page 19).

Note:

The fields on the File - AKR Allocate/Expand pop-up may vary depending on the
settings for the Center installation parameters, AKR-DSORG-VSAM and SMS. See
the ASG-Center Installation Guide for more information.

18
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Verify that the name is correct and enter the appropriate values for the Management
Class, Storage Class, and Data Class fields if you are using SMS managed datasets.

Figure 7 shows a sample of how the File - AKR Allocate/Expand pop-up looks for a
VSAM AKR without SMS support installed.

Figure 7 « File - AKR Allocate/Expand Pop-up for a VSAM AKR without SMS

File Wiew Extract Generate Search Logic List Options Help

File - AER Allocate/Expand

Command ===
3 - Submit JCL E - Edit JCL C - Specify Catalog

Expand existing ALKR . . . NO [Tes or Mol
L¥R data set nawme . . . . 'UIER.TE3T.AKR'

Volurme . . . . . . . .

Tnit . . . . . . . . . SYSDA [Generic unit nswme)

Primary space . . . . . 4000 [Primary amount in sbowve units)

Secondary space . . . . O [Secondary amwount in sbove units)

Job statement information:
//USER  JOB (LCCOUNT) ,MNAME,

A MSGCLASS=14
e INSERT '/+*ROUTE PRINT NOLDE.USER' HERE IF NEEDED.
e

|
|
|
|
|
|
|
|
|
|
Space units . . . . . . RECCRDZ [Records, Tracks or Cylinders) |
|
|
|
|
|
|
|
|
|
|
'

If you did not specify SMS managed datasets in the CENTER installation parameter
SMS while installing Center, the fields pertaining to SMS are not displayed. In that
case, enter these values as required:

a

b

For VOLUME, type the value where the permanent AKR is to be placed.
Review the Space units and Space amount values.

Type the appropriate UNIQUE parameter for the volume selected if you are
allocating a VSAM AKR.

If this dataset needs to be cataloged under a user catalog, type C on the
command line to display the AKR Catalog Information pop-up. Enter the
Catalog DSN and password as required, and press PF3/15 to exit.

Type the JOB statement information for your site and type S on the command
line to submit the job.

After the job finishes, verify that the AKR was successfully allocated and
initialized.

Press PF3/15 until you return to the Encore Primary screen.

19
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To analyze the demonstration program

1 Select File P Analyze to display the File - Analyze Submit pop-up, as shown in
Figure 8.

a  Type the AKR dataset name from step 2 on page 18.

b  Set the Compile flag to N.

¢  Type S on the command line to submit the job.

d  Verify that the analyze job completed successfully. If the analyze job did not
completed successfully, see the ASG-Center Installation Guide for additional

information.

Figure 8  File - Analyze Submit Pop-up

File WView Extract Generate Search List Options Help

File - Analyze Submit Progrsm: VIARDEMO
Command ===>

E - Edit JCL 3 - Submwit JCL

Compile and link JCL (PD3 or sequential):
Data set name 'UTIER.TEST.CHNTL (MEMEER)

Analyze features (¥/N):
A3G-Encore: ¥

ALEFR data set name 'UIER.TEST.LER'
AKR program name (if owverriding PROGRAM-ID)

Analyze options:

Compile? (Y/M) . . . . . « . . . N [T if needed hy features)

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
| Link load module reusable? (¥/N) N [L3G-SmartTest only
!
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These are the compile and link JCL dataset names required for the Compile and link JCL
field on the File - Analyze Submit pop-up shown in Figure 8 on page 20:

ASG.VIACENxx.CNTL(VIAACMP1) For program VIARDEMO.

ASG.VIACENxx.CNTL(VIAACMP2) For programs VIARDRIV and VIARSUBR.

ASG.VIACENxx.CNTL(VIAACMP3) For program VIARANOM (*). You can use
the Analyze options field shown in Figure 8
on page 20 to enter analysis report
parameters or to use the batch-driven
Anomaly Repair Facility.

ASG.VIACENxx.CNTL(VIAACMP4) For programs VIARBRWS.

(*) For VIARANOM, you can use the Analyze options field on the File - Analyze Submit
pop-up to enter these analysis report parameters. These parameters are used to produce
analysis reports that help you understand and diagnose analysis problems and anomalies:

o VIARERPT - stops the analysis process after the analysis report is generated.

J VIARERPTAN - continues the analysis process after report generation and saves
the information in the AKR.

o NUMPRMA (##) - specifies the number of parameters allowed before a CALL is
listed in the Excessive Parameter List report.

e  RPTCEN - centers the generated report (default is left justified).
You can also use these analyze parameters in the Analyze options field to use the

batch-driven Anomaly Repair Facility to correct certain anomalies that may exist within
your code:

o VIAANOMF - runs the Anomaly Repair Facility in batch mode. You can also use
the online method by entering these additional operands on the Anomaly
Facility - Batch Submit screen:

— PARM(user parm) - any valid user parameter (e.g., DEBUG).

— ANOMALY - required, used to specify these types of anomaly fixes:
—  OOPGT - for out of perform GOTO
— GTD - for GOTO depending
— IPR - for inconsistent performance ranges

—  COMMENT(YES or NO) - includes/omits original commented out code in new
repaired code. YES is the default.

21



ASG-Encore Installation Guide

22

—  DSN - name of the output dataset for the repaired code. If you do not specify a
dataset name, output defaults to DD VIAANOUT. If DSN is a sequential file,
do not code the MEM parameter.

—  MEM - member name of the output dataset if you specified a DSN. Do not code
if DSN is a sequential file.

— HEADER(YES or NO) - includes/omits an ASG header at the beginning of
repaired code. YES if the default.

Example:

VIAANOMF, PARM (DEBUG1) , ANOMALY (OOPGT, GTF, IPR) , COMMENT (YES) ,
DSN (/' ASG.ANOMALY.REPAIRED.CODE’) ,MEM (MEM1) , HEADER (YES)

See the online help, the ASG-Encore User’s Guide, and the ASG-Encore Reference
Guide for more information about these parameters.

Validate the Analyze Submit CLIST by entering either of these commands from the
ISPF Primary Menu:

TSO VIASUBDS 'ASG.VIACENxx.CNTL (VIAACMP1) '
Or

TSO VIASUBDS 'ASG.VIACENxx.CNTL (VIAACMP2) '

Repeat step a through step d from "To analyze the demonstration program" on page

20.

See the online help for more information about the Analyze Submit pop-up.



2 Customization

To verify Structure View

1

2

Select File » Open to display the File - Open Program pop-up.

Enter the AKR dataset name and the program name VIARDEMO. If applicable,
enter the appropriate dataset password. Press Enter to open the program and display
the Encore Primary screen.

Select View P Structure to display the View - Structure View Request pop-up, as
shown in Figure 9.

Figure 9 « View - Structure View Request Pop-up

File WView Extract Generate Search Logic List Options Help

View - 3tructure View Regquest
Comrna
Type regquest options. Then press Enter. For a name selection list
for a range (other than 1 or 2), type a pattern (e.g. ABC*) in the
nemwe field.

Levels 3 of 3 of depth

Rancge
1 Procedure division
All entry points
Perform range name
Entry point name

Nested progrswm name

[, T - R SN Y

Name

Options
_  BRepetition

Enter these values in the appropriate fields:

o Levels: 3 (maximum)

o Range: 1 (procedure division)

The Name field and Repetition option should be left blank. Press Enter to display

the Structure View screen showing the message ASG1582I 3 OF 3 LEVELS
DISPLAYED IN THE VIEW.
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Select Search P Data to display the Search - Data Name pop-up, as shown in
Figure 10, and enter this information:

Data Name: WK-INTEREST

References: 1

Indirect impact: 1 (If Insight is installed)
Size change levels: 1 (If Insight is installed)
Direction: 1

Options: Blank

Action: 1

Figure 10 » Search - Data Name Pop-up

File WView Extract Generate Search Logic List Options Help

Search - Data Name

|
c
| Type & data name and select search options. Then press Enter. For
| & selection list, enter a pattern (e.g. ABC*) in the nsame area.
i
+ | Data name WE-INTEREST
[
| | References Indirect impact Size change
| 1 1 1. &ll 1 1. HNone levels . . . 1
+ | 2. Defs 2. ©Of size change
| 3. Uses 3. ©Of walue change
+ | 4, Mods
[
| | Direction Options Action
| 1 1 1. &ll _ Ho data aliasing 1 1. Find
+ | IN-clause. .. 2. Highlight
| 3. Exclude
|
!
ES | |OF-DAYS | |-ACTICN | |CCT THRU|

==+

[ [ | | UPDATE®|
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Leave the Options and (if present) Size change levels fields blank. Press Enter to
redisplay the Structure View screen.

On the Structure View screen, the message ASG0443I 3 DATA REFS: 1 DEF,
1 USE, 1 MOD, FOUND FOR WK-INTEREST should display. The box labeled
UPDATE-ACCT THRU UPDATE* should be highlighted.

Note:

If Insight is installed complete step a through step d on page 26. If Insight is not
installed, proceed to step 7 on page 26.

If Insight is installed:

a  Select Logic » Data to display the Logic Order Search - Data Name pop-up and
enter this information:

Data Name: WK-INTEREST
Start line/label: PROCEDURE
References: 1

Direction: 1

Options: Blank

Action: 1

b  Press Enter. The short message, 1 REF (S) REACHABLE displays. The box
labeled UPDATE-ACCT THRU UPDATE* should be highlighted.
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¢ Select View » Zoom In, or type ZOOMIN on the command line and move the
cursor to the highlighted box (UPDATE-ACCT THRU UPDATE¥). Press
Enter to display the View - Source pop-up, as shown in Figure 11. This pop-up
displays with the code for the selected unit highlighted and the rest of the
program excluded.

Figure 11« View Source Pop-up

| View Search Logic List Options Help |
| |
| View - Source SCREEN POSITICHNED

| Command ===3 Soroll ===»> C3R

| |
| 000273 UPDATE-ACCT. FERF ENG

| --- - - - = = = - - - - - - - - - 1 LIMNE MNOT DISFLAYED

| 0O0z75 FPERFORM INIT-ACTICHN-RECORD. FERF ENG

| --- - - - = = = - - - - - - - - - 1 LIMNE MNOT DISFLAYED

| oooz7? IF ACCT-TYPE OF ACCT-RECORD = 'INT' FERF ENG

| 0O0zZ7s MCWVE CHE-INTEREST-RATE TO INTEREST-RATE FERF ENG

| oooz7e ELSE IF ACCT-TYPE OF ACCT-RECORD = 'CHE' FERF ENG

| ooozZso MCWVE ZERO TO INTEREST-EATE FERF ENG

| OOozZs1 ELSE IF ACCT-TYPE OF ACCT-RECORD = 'MMA' FERF ENG

| Ooozs: MCWVE MMA-INTEREST-RATE TO INTEREST-RATE FERF ENG

| 0O0283 ELSE IF ACCT-TYPE OF ACCT-RECORD = '3AW! FERF ENG

| DO0ZS4 MCWVE SAV-INTEREST-RATE TO INTEREST-EATE. FERF ENG

| --- - - - = = = - - - - - - - - - 1 LIMNE MNOT DISFLAYED

| OO0Zsa IF ACCT-MULTI-ACCT = 'YE3' FERF ENG

| ooozsv? ADD CHE-MULTI-ACCT-RATE T2 INTEREST-RATE FERF ENG

| 0O0zZss MCVE ACTICHN-MULTI-ACCT TO WORK-ALCTICHN-EEASCH FERF ENG

| ooozse PERFORM INITIATE-ACTICHN. FERF ENG

! !

d  Press PF3 twice to return to the Encore Primary screen.
If Insight is not installed:

7  Select View P Tree to display the View - Tree View Request pop-up and enter this
information:
— Levels: 4 (maximum)
—  Contents: 1
— Range: 1

8 Leave the Name and Repetition option fields blank. Press Enter to display the Tree
View screen (Figure 12 on page 27).
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The message ASG1582I 4 OF 4 LEVELS DISPLAYED IN THE VIEW
displays, as shown in Figure 12. Type LEVELS 3 on the command line and press
Enter.

Figure 12 » Tree View Screen

File W“iew Ewtract Generate Search List Options Help
Tree Yiew LIME 1 OF 21
Command === Scroll ===: CER
TOP OF DATA
pEoEuE  PROCECRURE DIWISION USIMG COMTROL-PARAMETERS, BRAMCH-BALAMCE.
[lelale]ap IMITIALIZE-PGH.
CICGIEE S OFEM-FILES.
CIDEEE GET-HUM-0F -LATS.
elelalelaky SUM-TOTAL -DATS.
[lelale]ap ACCT-MAIMTEMAMCE.
CICGIEE S ACCT-MAIHTENANCE-ERIT.
CIDEEE IMITIATE-ACTION.
GIEGEEE ACCT-MAIMTEMAMCE-EXIT. REFEATELD
[lelale] b UFDATE-ACCT.
clelolelok) IMIT-ACTIOM-RECORL:.
Qoo IMITIATE-ACTIOM. REFEATELD
elelalelok IMITIATE-ACTION. REFEATELD
elelalelok) IMITIATE-ACTION. REFEATELD
elelalelak) REFEATELD
GIEGEEE ASG1SE2I 4 OF 4 LEYELS DISPLAYED IM THE YIEW.
CIDEEEE
GIEGEEEE ACCT -MAIMTEMAMCE-EXIT.

The message ASG1582I 3 OF 4 LEVELS DISPLAYED IN THE VIEW
displays as the number of levels displayed is reduced to 3, as shown in Figure 13.

Figure 13 » Tree View Screen with Levels Displayed Message

File W“iew Extract Generate Search List Options Help
Tree Yiew LIME 1 OF 15
Command ===k _ Scroll ===: CESR
TOP OF DRTA
oEooue  PROCECURE DIWISION USIMG COMTROL-PARAMETERS, BRAMCH-BALAMCE,
[lelale]ah IMITIALIZE-PGH.
CIGGGEEE OFEM-FILES.
pooEEE + GET-HUM-0F -DATS.
[lelale]ap ACCT-MAIMTEMAMCE.
CICGIEE S ACCT-MAIHTENANCE-ERIT.
CIDEEE IMITIATE-ACTION.
GIEGEEE ACCT-MAIMTEMAMCE-EXIT. REFEATELD
QooEEE + UFDATE-ACCT.
CIGGEEE UFDATE-ACCT-ERIT.
[E1E] TR 2R ERCEPTION-REFORT-1.
[lelale] o ACCT -MAIMTEMAMCE-EXIT.
[lelale]ah REFORT-FIMAL -CHTRE.
GEGGEE2 CLOSE-PGM.
[ele]ale] o
s b ASG1SE2I 2 OF 4 LEVELS DISPLAYED IM THE WIEW. bk
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10 Type JUMP on the command line, as shown in Figure 14, position the cursor on any
of the source lines, and press Enter.

Figure 14 » Tree View Screen

File W“iew Extract Generate Search List Options Help
Tree Yiew LIME 1 OF 15
Command === JUMP Scroll ===: CSR
TArF 0OF DATA
QO30 PROCEDURE DIVISION USIMG COMTROL-PARAMETERS, ERAMCH-BALAMCE ,
EEDEE2 IMITIALIZE-PGH.
QEOEEE OFEM-FILES.
AEOEE3E + GET-HUM-0F -DATS.
noonoz ACCT-MAIMTEMAMCE.
CIEEEEE ACCT-MAIMTENAMCE-EXIT.
QEOEEE IMITIATE-ACTION.
BEOEE3 ACCT-MAINTENAMCE-EXIT. REFEATEL
QE@EEs + UPDRTE-ACCT.
QE@EEE UPDATE-ACCT-ESIT.
QE@EEE EXCEPTION-REPORT-1.
AEOaE2 ACCT-MAINTEMAMCE-EXIT.
EEDEE2 REPORT-FIMAL-CHTRS.
QE@EE2 CLOSE-PiGHM.
BEOEE3
dbtababen bbb | ASG15821 3 OF 4 LEYELS DISPLAYED IM THE WIEW. | bbbt

The View - Source pop-up displays with the cursor positioned on the selected line,
as shown in Figure 15.

Figure 15 * View - Source Pop-up Showing JUMP Results

VYiew Search List Options Help
View - Source Frogram: YIARDEMO

Command === Scroll ===r CSR
oaE24z  [CCT-MAIMTEMAMCE.
QRE244
ooaz45 READ TRAM-FILE
GREZ24E AT EMD
QaE247 MOME EOF-LITERAL TO TRAM-FILE-FLAG
OREZ245 GO TO ACCT-MAIMTEMAMCE-EXIT.
QaEz49
GRE25E ACD +1 TO TRAM-CHT.
oaEz51
QREZ5Z2 MOME TRAM-ACCT-KEY TO ACCT-KEY.
QRE253
QaEz54 READ ACCT-FILE  KEY IS ACCT-KEY
QREZ5S IMWALID EEY
ORA25E MOME ACTIOM-MISSIMG-ACCT TO WORK-ACTION-REASOM
GLEEZST MOME SPACES TO ACCT-RECORD
QREZ5E FERFORM IMITIATE-ACTION
QREZ259 MOWE +4 TO WORK-RETURMH-CODE

11 Press PF3 twice to return to the Encore Primary screen.

28



To verify Perform Range extract processing

1

2 Customization

Select Extract » Perform Range and press Enter to display the Extract - Name Logic
Segment pop-up.

Accept the default name or type PERFORM-RANGE-0001 in the Name field, and

press Enter to display the Extract - Perform Name List pop-up.

Press PF5 (Filter) to display the Extract - Perform Range Filter pop-up, as shown in

Figure 16.

In the COBOL Subset field, type the subset name OUTPUT and press Enter to
redisplay the Extract - Perform Name List pop-up, which shows the PERFORM
Ranges associated with the COBOL subset OUTPUT (see Figure 17 on page 30).

Figure 16 » Extract - Perform Range Filter Pop-up

(i

Extract - Perform Namwe List

Extract - Perform Range Filter

Type information for filtering PERFORM Range Name list.

PERFORM Name

Data Name

Use Context

1 1. EReferences
Z. Uses
3. Modifications

Line Range . .

Options
/  Aliasing

COBOL Subset CUTFUT

Text Pattern

REPORT-FINAL-CNTRS

PF4=Wiew PF5=Filter

PF17=3%ort
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5  Type S on the INITIATE-ACTION line and press Enter to highlight the line, as
shown in Figure 17.

Figure 17 » Extract - Perform Name List Pop-up

Extract - Perform Namwe List
Command ===> Seroll ===»> CSR

Select PERFOREM Range name (s) for extract. Then press Enter. Press
Enter when cowmplete. Use Z30RT comand to order column by value.

3 - Zelect V - View Source T - Unselect
Size Times PERF Direct Subord
PERFOREM Range Name Lines % PERF by FPERF= FPERF=
- < ———— —— >
_ ACCT-MAINTENANCE THRU ACCT-MAI 27 12.86 1 1 3 q
- 1 1 il il
5 INITIATE-ACTICH 13 6.19 5 Z a a
_ BREPORT-FINAL-CHNTR3I 5 Z.38 1 1 a a
UPDATE-ACCT THRU UPDATE-ACCT-E 52 Z4.76 1 1 Z Z

FEEREELRAEALRAARRLRARARAXRATRLAT BOTTOM OF DATL FrA S oA na s aa A n S w A A ARG RARAL LT

PF4=View PF5=Filter PF17=3ort

|
|
|
|
|
|
|
|
|
|
|
| EXCEPTION-REFORT-1 16 7.62
|
|
|
|
|
|
|
|
|
|
'

6  Press Enter again to return to the Encore Primary screen.
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2 Customization

7 Select View P Logic Segment to display the View - Select Logic Segment pop-up,
as shown in Figure 18. Select PERFORM-RANGE-0001 and press Enter.

Figure 18 » View - Select Logic Segment Pop-up

Wiew - Select Logic Segment 1 LOGIC SEGMEMTS
Command ===k _ Scroll ===r C3SR
S - Select
Progtam Logic Segment Mame Description
S VIGRDEND  PERFORM-RANGE-0DO1 Perform Range

EOTTOM OF DATA

The Source View screen displays with the logic segment lines highlighted and the
non-segment lines excluded, as shown in Figure 19.

Figure 19 » Source View Screen

File W“iew Extract Generate Search List Options Help
Source Yiew Fraogram: YW IARDEMO

Command ===k _ Scroll ===: CER

e T R 19 LIMES MOT CISFLATELD
oooz24zs ACCT-MAINTEMAMCE. LOGICSEG
--- - - - = - - - - = = - - - - = - - 1 LIME HOT DISPLAYEL
Qo245 READL TRAM-FILE LOGICSEG
GEL24E AT EMD LOGICSEG
QEoz4T MOME EOF-LITERAL  TO TRAM-FILE-FLAG LOGICSEG
GIEE24E GO TO ACCT-MAINTEMAMCE-EXIT. LOGICSEG
--- - - - - - - - - - - - - - - - - - 1 LIME HOT DISPLAYED
GIEL250 ADD  +1 TO TRAM-CHT. LOGICSEG
--- - - - = - - - - = - - - - - = = - 1 LIME MOT DISPLAYED
QEE2S2 MOME TRAM-ACCT-KEY TO ACCT-KEY. LOGICSEG
--- - - - - - - - - - - - - - - - - - 1 LIME MOT DISPLAYEL
QEE2sd REAL ACCT-FILE KET IS5 ACCT-KEYT LOGICSEG
QEL2ES IMVALID KEY LOGICSEG
GQEE25E MOME ACTIOM-MISSIMG-ACCT TO WORK-ACTION-REASOH LOGICSEG
GEL2ST MOVE SPACES TO ACCT-RECORL LOGICSEG
QEL2SE PERFORM IMITIATE-ACTION LOGICSEG
GEE25S MOWE +4 TO WORK-RETURH-CODE LOGICSEG
GEOZED GO TO ACCT-MATMTEMAMCE-EXIT. LOGICSEG

8 Press PF3 to return to the Encore Primary screen.
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To save the Logic Segment
1 Select File P Save Segment to display the File - Save Logic Segments pop-up.

2 Select PERFORM-RANGE-0001 from this pop-up and press Enter to display the
File - Save Segment pop-up, as shown in Figure 20. Enter this information:

o Name: PERFORM-RANGE-0001
o Description: PERFORM-RANGE EXTRACT
. Long Description: TEST SEGMENT FOR INSTALLATION

3 Press Enter to display the short message SAVE SUCCESSFUL.

4  Press PF3 to return to the Encore Primary screen.

Figure 20 » File - Save Segment Pop-up

File - Sawve Segment
Command === Soroll ===>x C3R

Type segment definition information. Then press Enter.

Chijective . «. . . & FPerform Range

Author . . . . . . @ USERID

Created . . . . . : DD-MMM-¥¥YY HH:MM:3%
MName . . . PERFCRM-RANGE-O0O01

Description PERFORM-RANGE-EXTRACT

Long Description:
TEST SEGMENT FOR INSTALLATICN.
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2 Customization

To verify Logic Segment generation processing

1 Select Generate » COBOL Module to display the Generate - Select Logic Segment
pop-up, as shown in Figure 21. Select PERFORM-RANGE-0001 and press Enter to
display the Generate - COBOL Module pop-up (see Figure 22).

Figure

21 » Generate - Select Logic Segment Pop-up

Generate - Select Logic Segment 1 LOGIC SEGMEMTS
Command === Scroll ===} CER
5 - Select
Progtam Logic Segment Mame Description
S VIARDEMD  PERFORM-RANGE-nOB1 Perform Renge

EOTTOM OF DATA

VIARDEMYV displays in the Program ID field on the Generate - COBOL Module

pop-up. Leave the Options field blank.

Figure 22 » Generate - COBOL Module Pop-up

C

File W“iew Extract Generate Search List Options Help

Gererate - COBOL Module Frogram: VIARDEMO
Type Frogram Il and select geheration options.
stobshistsbsbokohstsb bt bk

Objective . . & Perform Range T
Frogram I . . YIARDEMY
Options ey

CALL= to IO Modulels) shsfrsbshirtkstesh

stk

sk

ASG42121 DEFAULT PROGRAM ID WALUE ASSIGHED. YERIFY, AMD CHAMGE IF
MECESSARY.

Copyright Allen Systems Group, Inc., an unpublished work.
A propristary product of A5G, Inc. Use restricted to authorized licensees.
Vizit the ASG Support Web Site at www. asg.com
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2 Press Enter to display the Generate - Specify Perform Range ENTRY Names
pop-up, as shown in Figure 23.

Figure 23 » Generate - Specify Perform Range ENTRY Names Pop-up

Generate - Specify Perform FRange ENTRY Hames
Command ===3 _ Scroll ===» CSR

Epecify the ProgramID and ENTAY names aof the modules to be generated.
S - Split H - Howe I - Inte + - Espand - - Cellapse

Program EHTRY PERFORH Range Mame

EREEEEREEKEREE AR NEE KEMER RN KNNE TOP OF DATA 4% K000 3000 5 0003000 E R H
Y IARDEMY *IMNITIATE-ACTION

e se ek xenaesewxewxexx BEOTTOM OF DATH A% ertuet s et et it s Eik it

3 Press Enter to display the Generate - Multi-module PERFORM Ranges pop-up (see
Figure 24 on page 35).
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2 Customization

Select VIARDEMYV and press Enter to display the Edit screen. A COBOL
subprogram corresponding to the logic segment is generated. The Edit screen
appears displaying the subprogram. The message ASG16081 ENTER THE
CREATE COMMAND TO SAVE THE CORBROL PROGRAM also displays.

Figure 24 » Generate - Multi-module PERFORM Ranges Pop-up

Generate - Multi-module PERFOAM Ranpges
Command === Scroll === CIR

Select the module o generate, then press Enter,

FProgram ID ENTRY MName FERFORM Ramnge Mame

FAXAMELELKXAXARELXLAX L XA RELXLRELE TOP OF DATH £ XX XKLL XAMELKLRELXAREL KN

5 YIARDEMY INITIATE-ACTION
FEHEMER LR AR R R e kwy BOTTOH OF DATEA #¥Md SRR e SEREEREMEE %W

Press PF3 four times to return to the Encore Primary screen.
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To verify program Edit processing

1 Select File » Edit Program to display the File - Edit Options Request pop-up, as
shown in Figure 25.

Figure 25 « File - Edit Options Request Pop-up

File View Extract Generate Search List Options Help

File - Edit Options Request Program: YIARBRWS
If desired, select the Edit Options
screen digplag, Then press Enter. 2K K KKK K KKK KKK K XK K K K K K K KK K XK X X
KKK K K KKK 3K KK KKK K KKK KK K K K KK K
Options KKK K
/ Display options screen AR KKK
KKK XK KK XK KKK X KK
B OKKEKKEK  KKOKEKNK XK KKK K KK
KKK X KKK K K KKK K O KOK K KKK
O K KK KK KK AOK KKK K KKK XK
XK XK KKK KK OR KR KK K K KK X K R KR K OK K X X KR KK KK KR K K K K KR KK X KK
R KK K SR K KKK KKK K KK R K KK K KR KK KK K R OK K KK R K KK K KR KK K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

2 Type any non-blank character in the Options field and press Enter to display the Edit
Options pop-up (see Figure 26 on page 37).
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2 Customization

Ensure that the Source Manager is PDS, as shown in Figure 26 and press Enter to
display the Edit Entry Panel (see Figure 27).

Figure 26 » Edit Options Pop-up

File View Extract Generate Search List Options Help

File - Edit Options Request Program: YIARBRWS
I Edit Options 5
s 3K 3K 3K 3K KK K KK K 3K K 3K 3K K 5K 3K 3K 3K K K 3K K 3K 3K K 3K K K
Source Manager KK 3K K K K K K 3K KK 3K KK K 5K 3K 3K K K KK K K 3K K K K
1 1. PDS/Sequential LTS
2. Librarian KKK
3. Panvalet KK KK MK KKK 3K OK KKK KK
-- 4, scLw | =m=m--- TOKKEKE  KKKKXK KKK KK KKK
5. Other (User) HEKEKK KKK EXK
KKEKKE  KKKKK AKX

----------------------------- KKK KKK KKK 3K KK 3K KK K KKK KKK KK K K K
KK KKK KK 2K K K 2K K K 2K K K 2K K 3K KK 3K K K K KKK 2K K 2K K K 2K K 2K K K 2K K K KK K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

On the Edit Entry Panel, type the dataset name of the Encore product installed CNTL
library in the PROJECT, GROUP, and TYPE fields. Type VIARDEMO in the
MEMBER field and press Enter to display the Editor screen (see Figure 28 on page
38).

Figure 27 » Edit Entry Panel

Edit Entry Panel
Command ===%

ISPF Library:

Froject . . . ASG

Greap . . . . YIACEMWz= |

Tuype . . . . CHNTL

Member . . . YIARDEMO [Blank or pattern for member selectien list)

Other Partitiened er Sequential Data Set:
Data et Hame
Wolume Zerial . . . [1f net cataloeged]

Workstatien File:
File Mame .

Dptians
Initial Macro . . . . { Canfirm Cancel/Heve/Replace
Profile Mame . . . . . Mized Mogde
Farmat Mame . . . . . Edit on Morkstation
Data Set Passward . . Freserve YE record length
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5  Type DISPLAY on the command line and press Enter, as shown in Figure 28. The
lines of the current logic segment are displayed and the non-segment lines are
excluded.

Figure 28 » Editor Screen

ASG-Encore EDIT - YIARMED.FPROD.CHTL{YIARDEMO) - EE.00 COLUMMHS 20281 a7z
Command ===r DISPLAT Scroll ===: CER
Top of Lata
QEO1E0 aa01a8 IDENTIFICATION DIVISION.

QOOZE0 AE0208 PROGRAM-I0. YIARDEMO.

QOO3E0 20208 AUTHOR. ASG DEMOMSTRATION.

GIDOSELD B4R

QEOSE0 Aa05

CIEEEEL EEEEEED:: THIS FROGRAM DOES THE MOMTH EMD CALCULATIOMS FOR EACH TYPE #
QRDOTOL Q0DTOD: OF CHECEIMG ACCOUMT CRRRIED BV THE UMIYERSAL BAME. IT *
CIDQZEL BESEE:: HAMDLES THE FOLLOWIMG TYPES OF ACCOUMTS. *
CIDCREE DR CHECKIMG WITH IMTEREST *
CIELEEE EE ] A CHECKIHG WITH MO IMTEREST *
ooiiog oollo MOMEY MARKET ACCOUMT CHMAD *
CICL2EE B 26 SAYINGS ACCOUNT *
GIDLZEE L 20 IT ALED UPDATES THE ACCOUMT BALAMCE, BRAMCH BALAMCE AMD *
GIE TG B a5 EfHE BALAMCE. *

Q01500 QELS00

GEIEE0 BE1EDD

aoiveo aaives EMVIROMMENT DIVISION.
ek
el ASG1ER2I EMTER THE DISPLAT COMMAMD FOR LOGIC SEGMEMT IMFORMATION. |
aoz
GEZIE0 Aa2108 IMPUT-0UTFUT SECTION.

6 Type FX WK-INTEREST on the command line, as shown in Figure 29, and press
Enter.

Figure 29 » Editor Screen - FX WK-INTEREST Command

BSG-Encore ERIT - YIRRMED.FPROD. CHTL(YIARDEMO) - BE.EE COLUMME Qo081 aaa7z
Command === F¥ LK-INTEREST Scroll ===: CSR
Top of Lata
- - - - - - - - 37 Line(s) not Displayed

HE3300 61 ﬁCCT-RECDRD.
- - - - - - - - - - - - - 1 Linels) not Displayed

EE4EaE o= HCCT KET.

- - - - - - - - - - 1 Linel(s) not Displayed
HE4200 IB ﬁCCT TYPE PIC W3,

- - - - - - - - - - - 2 Linels) not Displayed
EE45a0 o= ﬂCCT-NIH-BﬁLﬂHCE FIC S90E)wa9.

HE4EEE b5 ACCT-AVG-BALAMCE FIC S90E)wa9.

ooyl 0] ﬁCCT NULTI ﬁCCT PIC HE3.

- - - - - - - - - 1 Line(s) mnot Displayed
EE43aE BS ﬂCCT INTEREST PIC SACEIVIT,

- - - - - - -15 Lineis) not Displayed
HESEE0 Bl TRHH RECDRD.
- - - - - - - - - - 1 Linefs) not Displayed
[oloist=dela] BS TRﬁN ﬁCCT KET
- - - - - - - - - - 25 Linei(s) not Displayed
EEd E " .
EEES ASG1E04I ALL LOGIC SEGMEMT LIMES WERE DISFLATED.

t Displayed
QRETE0 77 CHK-IMTEREST-RATE FIC 59(4)V9(4) COMP-2
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2 Customization

If SmartEdit is not installed, the message COMMAND FX NOT FOUND displays, as
shown in Figure 30.

Figure 30 » Editor Screen - FX Command Not Found Message

COMMAND FX NOT FOUND

If SmartEdit is installed, the message ASG0639I 3 DATA REFS, 1 DEF, 1
USE, 1 MOD found for WK-INTEREST displays.

7  Ifnecessary, erase the FX command and return to the Encore Primary screen by
pressing PF3/15 four times.

To validate IDMS support by analyzing an IDMS program

1 Select File P Analyze to display the File - Analyze Submit pop-up, as shown in
Figure 31.

Figure 31 « File - Analyze Submit Pop-up

File WView Extract Generate Search List Options Help

File - Analyze Submit Program: VIARDEND
Command ===

E - Edit JCL 3 - Submwirt JCL

Compile and link JCL (PD3 or secquential):
Data set nawme 'UIER.TEST.CHNTL (MEMEEER]'

Analyze features (Y N):
AZG-Encore: ¥

AKR dats set nsme 'UIER.TEST. AKR!'
AKER progratm hame |if overriding PROGRAM-ID)

Analyze options:

Compile? (¥/HW) . .« & « « &« « « M [T if needed by features)
Link load wodule reusable? (¥/M) N [ASG-3martTest only

2 Enter the dataset name for the compile and link JCL for the IDMS program to be
analyzed.

3 Enter the AKR dataset name.

4  Set the Encore analyze flagto Y.
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Type S on the command line and press Enter to submit the analyze job.
Verify the analyze job ran successfully by checking for a return code of 0 or 4.

Note:
Return codes higher than 0 (zero) usually indicate a compiler message.

To validate DB2 support by analyzing a DB2 program

Note:
If you have DB?2 installed, verify that ASG.VIACENxx.CNTL(VIASBIND) has
been run (see the ASG-Center Installation Guide for more information). This
installation step is required for sites using DB2. Failure to complete the DB2
installation step results in erroneous behavior by ESW products.

Select File » Analyze to display the File - Analyze Submit pop-up.

Enter the dataset name for the compile and link JCL for the DB2 program to be
analyzed.

Enter the AKR dataset name.

Set the Encore analyze flagto Y.

Type S in the command input area and press Enter to submit the analyze job.
Verify the analyze job ran successfully by checking for a return code of 0 or 4.

Note:
Return codes higher than 0 (zero) usually indicate a compiler message.

Select File P Close and press Enter to close the VIARDEMO program. Save any
logic segments, if desired.

To verify parameter-driven anomaly repair processing

Complete these steps if you entered any parameter-driven anomaly repair parameters in
the Analyze options field on the File - Analyze Submit pop-up (see Figure 8 on page 20).
This section verifies the VIARANOM anomaly repair parameter processing discussed in
"To analyze the demonstration program" on page 20.

Select File » Open to display the File - Open Program pop-up and select
VIARANOM.



2 Customization

Type VIARERPT in the Analyze options field and submit the VIARANOM analyze
job. When the job finishes review the DD VIARERPT output, which shows the
anomalies that have been found. Because of the VIARERPT option used in this
example, the analyze job will not finish and will not add VIARANOM to the AKR.

Review the output from DD VIARERPT, noting that VIARANOM contains three
anomalies that can be repaired. Perform a second analysis using the these parameters
in the Analyze options field:

VIAANOMF, ANOMALY (00PGT, GTF, IPR)

Submit the job and verify that it completes with no errors. Review the DD
VIAANOUT output to verify that it contains the repaired code. Verify that an ASG
header has been generated at the top of the generated code and that the repaired
code is commented out and new code has been added.

Using the generated repaired anomaly code, perform a normal Encore analyze with
no anomaly options or parameters and verify that it analyzed correctly.

Perform the VIARANOM analyze again, but this time use the DSN parameter to
send the output results to an allocated PDS and member. Set the COMMENT and
HEADER parameters to NO. Submit the job and verify that the repaired code has
been written to the specified PDS and member. Verify that the output does not have
an ASG header added to it and that the original fixed code is no longer commented
out.

Perform the VIARANOM analyze one more time, sending the anomaly output to an
allocated sequential file. Submit the analyze job and verify that the repaired code was
written to the sequential file.

Select File P Close and press Enter to close the VIARANOM program. Save any
logic segments, if desired.

To verify online panel-driven anomaly repair processing

Complete these steps if you entered any online panel-driven anomaly repair parameters in
the Analyze options field on the File - Analyze Submit pop-up (see Figure 8 on page 20).
This section verifies the VIARANOM anomaly repair processing discussed in "To
analyze the demonstration program" on page 20.

1

Select File » Open to display the File - Open Program pop-up and select
VIARANOM.

Type VIARERPTAN in the Analyze options field and submit the VIARANOM
analyze job. When the job finishes review DD VIARERPT, which shows the
anomalies that have been found. The analyze job finishes and adds VIARANOM to
the AKR.
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Select File » Anomaly facility to display the File - Anomaly Facility selection screen
and select Batch Anomaly Repair to display the Anomaly Facility - Batch Submit
pop-up. Enter the AKR dataset name and AKR program name fields (VIARANOM
for the program name). Select the type of anomalies to repair from the Anomalies to
be repaired section. Verify that the job information is correct and submit the job.
When the job finishes, verify that there are no errors and review DD VIAANOUT to
verify that it contains the repaired code. Verify that an ASG header has been
generated at the top of the generated code and that the repaired code is commented
out and new code has been added.

Using the generated repaired anomaly code, perform a normal Encore analyze with
no anomaly options or parameters and verify that it analyzed correctly.

Perform the VIARANOM analyze again, but this time use the Output dataset name
and Output member name fields to send the output results to an allocated PDS and
member. Press PF4 and deselect the Comment out changed lines? and Generate ASG
header? fields. Submit the job and verify that the repaired code was written to the
specified PDS and member, the output does not contain an ASG header, and the
fixed code is no longer commented out.

Perform the VIARANOM analyze one more time, sending the anomaly output to an
allocated sequential file by filling in the Output dataset name field. Submit the
analyze job and verify that the repaired code was written to the specified sequential
file.

Select File » Close and press Enter to close the VIARANOM program. Save any
logic segments, if desired.



To verify anomaly report processing

Complete this section if you entered any anomaly report generation parameters in the
Analyze options field on the File - Analyze Submit pop-up (see Figure 8 on page 20).
This section verifies the VIARANOM anomaly report generation parameter processing
discussed in "To analyze the demonstration program" on page 20.

2 Customization

» Validate the anomaly report(s) using the JES Master output generated from the

program analyze.

Note:

The VIARERPTAN parameter generates analysis anomaly reports. Sample

generated reports are shown in Figure 32 and Figure 33. See the ASG-Encore

User’s Guide and ASG-Encore Reference Guide for more information about

generating the anomaly reports.

Figure 32 « Dead Data (In Copy) Report

B R e T LR E LY

= DEAD DATA (IN COFY) REPORT *
= B
* This report lists the number of dead data |unreferenced data nemes) *

* found in each copy member. "

B R L R R L L R L T P T T T2y

HUMEER DEAD NAMES FOUND IN COPY MEMEER

z USER.HOLD.CNTL (MEMEER)
35 CICS330.LIBRARY (MEMEER]

DD-MMM-VYYY HH:MM:55

FPROGRAM: WIARANON

Figure 33 « Excessive Parameter List Report

B R L R R T T

* EXCESSIVE FARAMETER LIST REFORT *
* *
# This report lists all call sStatements using an excessive *
* mber of parameters. The default number of paraweters is 5. 7

B R R L R R L T T

LINE WUMBER CALLS PROGRAM HNUMBER of PARAMETERS
330 'DETRPT!' =l
363 'DETRPT' =

DD-MMM-YY¥Y HH:MM:53

PROGRAM: VIARANOM
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To verify CICS Server extraction
Complete this section to verify that the CICS server extract/generate facilities were

properly installed.

1 Select File » Open to display the File - Open Program pop-up. Specify VIARBRWS
in the Program Name field and press Enter to open the program.

2 Select Extract » Server and press Enter to display the Extract - Name Logic Segment
pop-up, as shown in Figure 34.

The name field on this pop-up contains a default name generated by Encore. You can
assign your own name to the Logic Segment or you can use the default name. For
this example, use the CLIENT-SERVER-0001 default name.

Figure 34 » Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARBRWS
Command ===
Type name of logic segment. Then press Enter.
KR K KK K KK K
Name . . . CLIENT-SERVER-0001_ KK AK KK KKK
R KK KK KK KK KK R KK K K KK KK K KKK K R KR KK KK KK XK XK KK K K KK KK R
KKK KK KR KK KK KK KK K KR K K KKK KR KR KK KK KK X K KKK X R K KK OK KK
KKK X KR KKK KR X KK X R XKOK K XXX
KKK K KKK KK KK KKK K KK KKK KK
K KKK KKK KR KK KK R K KKK K R KK K OK KK K KK KK R K KK OK KR KK KK R
R KKK KKK KK KK KK KKK KK KR KK KK R R KK KK KKK KR KK XK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

3 Press Enter to display the Server selection pop-up (see Figure 35 on page 45), which
contains a list of available server types.
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2 Customization

Type 1 to select CICS, as shown in Figure 35, and press Enter to display the CICS

Server Endpoints pop-up (see Figure 36 on page 46). The CICS Server Endpoints

pop-up contains all of the statements associated with the CICS member. You want to

extract all statements that contribute to the output screen.

Figure 35 » Server Selection Pop-up

File View Extract Generate Search List Options Help

Extract - Server Program: YIARBRWS

Select the type of server to generate.
2002 KK KR XK KK K KK KK KK KK XK

Tgpe KKK OK K KKK K K K K KK KK K K K K K K
1 1. CICs KKKKK
2. Self Directed AR KKK
KK XK KKK X KK
KKK XK KKK KK KK
————————————————————————————————————————————— O KOK K KKK
O K KK KK KK AOK KKK K KKK XK
KK KK KK KKK KKK KK KK K KK K KK K K K IR IOK KK KK KK K K K K
R KK K SR K KKK KKK K KK R K KK K KR KK KK K R OK K KK R K KK K KR KK K K

Copyright Allen Systems Group, Inc., an unpublished work.

¥isit the ASG Support Web Site at www.asg.com

A proprietary product of ASG, Inc. Use restricted to authorized licensees.

Note:

If you select the Self Directed server extract type, you can reduce the list of
selectable endpoints by pressing PF5. The Extract - Self Directed Server Filter
pop-up displays, allowing you to specify filtering criteria. See the ASG-Encore
User’s Guide and the online help for more information about the Filter - Self

Directed Server pop-up.
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5  Toensure that you are selecting the code you want to extract, type V next to the CICS
EXEC you want to view, as shown in Figure 36. Press Enter to display the View

Source pop-up (see Figure 37).

Figure 36 + CICS Server Endpoints Pop-up - View Option

Extract - CICS Server Endpeinis
Commard ===2 Scroll ===% CER

Salect the statement for each CICE Earwer Endpoint and press Enter to wview
the corresponding Startpoints, This screen Willl be redicplayed to allod

additianal Endpoints to be selected. Press Enter when all selections are
camplete .
5 - Select W - Wiew Source U - Unselect
oRo4s1 EXEL CICS SENMD HAF [ EROKWSE'] MAPSET L WIARBRW']
0n0daz ERASE EMD-EXEC.
¥ DQOGLE EXEE CICE SEMD HAF [ BROWSE'] MAPSET [ YIAREAW']
0ansLE ERASE EWD-EXEC.
nanNes: EXEG: CICS SEMD HAP [ BROWSE 1 MAFSET [ YIAREBRK 1 END-EXEC.
0AoB?2 EXEC CICS SENMD HAF [ EROWSE ] MARSET L VIAREBRL']
OQ0ET3 ERASE EMD-EXEC.
_ NGaBad EXEL CLICS SEMD HAP [ BROWSE'1 MAPSET YIAREAL']
n@neas ERASE EMD-EXEC.
0ag7as EXEC CICS SEMD HAP [ HEMU'1 HAPSET (" YIARMHU') ERASE EHWD-EXEC.

FELEEEEREEE R S R KRR R BOTTOM OF DATH SR HEMEE SRR RN e R e

6  Verify that the CICS EXEC server code selected represents the type of code you
want to extract. After verifying the code press PF3 to return to the CICS Server
Endpoints pop-up (see Figure 38 on page 47). If necessary, repeat this process until
you find the code you want to extract.

Figure 37 » CICS Server Extract View - Source Pop-up

| View Search Logie List Options Help |
| - - - - - - - - - - |
| View - Source SCREEN POSITICNEL |
| Command ===3> Soroll ===> CSR

| |
| 000273 TUPDATE-ACCT. PEEF ENG |
|l --- - - - - - = - - - - - - - - - 1 LINE NOT DISPLAYED |
| 000275 PERFORM INIT-ACTICHN-RECCORD. PEEF ENG |
| --- - - - - - = - - - - - - - - - 1 LINE NOT DISPLAYED |
| 000277 IF ALCCT-TYPE OF ARCCT-RECORD = 'INT!' FEEF RNG |
| 000275 MOVE CHE-INTEREST-RATE TO INTEREST-RATE PEEF RNG |
| oooz79 ELSE IF ACCT-TYPE OF ACCT-RECORED = 'CHE!' PEEF ENG |
| ooozso MOVE ZERO TO INTEREST-RATE PEEF ENG |
| 000251 EL3E IF ACCT-TYPE OF ACCT-RECORD = 'HMMAL' PEEF ENG |
| Ooozsz MOVE MMA-INTEREST-RATE TO INTEREST-RATE PEEF RNG |
| O00Z53 EL3E IF ACCT-TYPE OF ACCT-RECORD = '3AV!' FEEF RNG |
| O00zZ54 MOVE SAV-INTEREST-RATE TO INTEREIT-RATE. PEEF RNG |
| --=- - - = = = = - - - - - - - - - 1 LINE NOT DISPLAYED |
| ooozZse IF ACCT-MULTI-ACCT = '¥ES! PEEF ENG |
| 000257 ADD CHE-MULTI-ACCT-RATE TC INTEREST-RATE PEEF ENG |
| 000255 MOVE ACTION-MULTI-ACCT TO WORE-ACTICN-RELSCHN PEEF RNG |
| 0O00zZ59 FERFCRM INITIATE-ACTICH. FEEF RNG |
[— _ _ _ _ _ _ _ _ R
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2 Customization

Figure 38  CICS Server Endpoints Pop-up - Select Option

Extract - CIC3 Serwver Endpeints
Command ===3 Seroll === CER

Select the statement for each CICE Server Endpoint and press Enter to wiew
the corresponding Startpeints, This screen will ke redicplayed to allow
additienal Endpoints to be selected. Press Enter when all selections are
complete.

5 - Select VW - Yiew Source U - Unselect
0eads 1 EXEC CICS SEMD MAF['BROWSE') HRPSET (' VIARERM')
i[lokE ERASE END-EXELC.
= DDQGLE EXEC CICS SEND MAF['EAOWSE'] HAPSET (' VIARBRW']
NEOGLE ERASE EMD-EXEC.
_ N8EES2 EXEL CICS SEWD MAF['BROWSE') HRPSET [ WIARERW'1 END-EXEC.
"~ OpasTz EXEC CICE SEND MAF['BROWEE') HRPBET ['WIARERM')
0EaGTa EARSE EWD-EXELC.
_ ne0E3d EXEC CICH SEMD MAFI'EROWSE') HAPSET (' VIARBRW')
liflakE:1a ERASE EMD=EXEC.
000735 EXEC CICS SEMD MAF['MENU') MAPSETI YIRRHNU') ERSSE END-EXEC.

EN R MR N BRI Rk ¥ EOTTOM OF DAITE S0 e e 20 e M e 24

Type S in the indicated command area or press Enter to accept the selection (all
highlighted text is preselected. Press Enter to return to the CICS Server Endpoints
pop-up (see Figure 40 on page 48).

Figure 39 « CICS Server Startpoints Pop-up

CICS Server Startpeints
Commarnd ===% _ Ecroll === CER

Select statements for CICS Server Startpoints and press Enter. Press Enter
when celections are complete to return to the Endpoints coreen,

Endpaint
5 - Zelect VW - Yied Source U - lUnselect
oo ELE EXEC CICS RECEIVE MAP|['EROHSE') MAPSET('WIARERM')
o067 RESP (RESPONSE] END-EXEC.

R AWK KAMEE X e RN ewxex BOTTOM OF DATH ##4HERXEXEEHERER X R MR E KM EE XL

Type S next to the line you want to select, as shown in Figure 38, and press Enter to
display the CICS Server Startpoints pop-up (see Figure 39).
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The message displayed in the long message area confirms that the CICS Statements
for the EXEC CICS SEND code were successfully selected, as shown in Figure 40.
Press Enter to display the CICS Server Paths pop-up (see Figure 41 on page 49).

Figure 40  CICS Server Endpoints Pop-up - Selection Confirmation Message

Extract - CICS Serwer Endpoints

Command === Scroll === CSR
Select the statement for each CICS Serwver Endpoint and press Enter to wiew
the corresponding Startpoints.  This screen will be redisplaged to allow
additional Endpolnts to be selected. Press Enter when all selections are
complete.

5 - Select Voo Miew Source U - Unselect
— EoodEl EXEC CICS SEMD MAF( - BROWSE') MAFSETE YIARERW' )

oap4Ez ERASE EMD-EXEC.
— EOEELS EXEC CICS SENMD MAP('BROWSE') MAPSETC'YIARERW')

OHEELE ERASE EMD-EXEC.
— EORESZ EXEC CICS SEMD MAPL BROWSE') MAPSETL YIARERW') EMD-EXEC
— EORETZ EXEC CICS SEMD MAF('BROWSE') MAPSET('WIAREBRW' )

OROETS ERASE EMD-EXEC.
— EOEE34 EXEC CICS SEMD MAFT BROWSE' ) MAFSETL YIARERW' )

QREESS ERASE EMD-EXEC.
— E0aT3S EXEC CICS SEMD MAPC'MEMU') MAPSETC('WIARMMU' ) ERASE EMD-EHEC.

ASGHIEZI CICS STATEMEMTS SUCCESSFULLY SELECTED.




2 Customization

10 Default T (TRUE) or F (FALSE) selections have been made based on the selection
criteria, as shown in Figure 41. An X indicates that the code does not apply to this
extract. You can change the settings, if desired.

Figure 41 » CICS Server Paths Pop-up

Extract - CICS Serwver Faths
Command ===% _ Scraoll === CER

Tdentify conditionals which are definitely TRUE for the Serwer. those which
are definitely FAL3SE. and leaue Dlank the conditionals whnich may ke eitner
TRUE or FALSE. Press Enter when all selections are camplete.

T - TRUE F - FALSE blank - TRUESFALZE Wo- Yiew Source
T 0Q0283 IF EIBCALEN NOT = 0 THEM
% O0aOz7y IF EIECALEN = o THEM GO TO HEXT-LIMNE.
ooosa6 IF EIBCHLEN = 0 THEMW G0 TO TEST-STRATS.
F 0onE3ad IF EIBAID = DFHCLEAR THEN
F ngos4o IF EIBARID = DFHFF1 OR DIRI = "F° THEW GO T0 PAGE-FORHARD,
T 0Q0E41 IF EIBRID = DFHPF2Z QR DIRI = "E° THEW GO TO PAGE-EACEWARD.
EEHMEHEREEREE R HEREE RN R RER RS BOTTOM OF DATA $% 8% #583 £aM 8% S0 £RNEE 89S

11 Press Enter to return to the Encore Primary screen, which displays a message
indicating that the criteria for the statement extract was successfully selected.
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To verify CICS server generation

1

50

Select Generate » Server and press Enter to display the Generate - Select Logic
Segment pop-up, as shown in Figure 42.

Figure 42 » Generate - Select Logic Segment Pop-up

Generate - Select Lagic 3egment 1 LOGIC SEGHMENTE
Command ===§ _ Soroll === CSR
$ - Gelect
Frogram Logic Segment Mame Description
5 VIARERNS  CLIENT-SERVER-DOOL Clent Server

EEXEMNEFXFXXF AT RN AFRAFAFRENwx% 3 BOTTOM OF DATH *x 3 FrAFATEAFXEFXF LI F K REE X

Type S next to the Logic Segment name you want to select, or accept the default
selection, and press Enter to display the first Generate - HOST Copy Member
pop-ups (see Figure 43 on page 51).

Note:

The number of Generate - HOST Copy Member pop-ups displayed during this
procedure depends on the ending and starting statements selected on the
corresponding CICS Server Endpoint (see Figure 38 on page 47) and CICS Server
Startpoint (see Figure 39 on page 47) pop-ups. A minimum of two

Generate - HOST Copy Member pop-ups always display for a generated server.




2 Customization

Type the new name you want to assign to the DFHCOMMAREA copy member in
the Copy Member field (CPYCOMAR in this example, as shown in Figure 43).
Assign the Starting Level Number and Level Number Increment you want or accept
the defaults (CICS defaults to a record level of 5). Press Enter to display the second
Generate - HOST Copy Member pop-up (see Figure 44).

Figure 43 » Generate - HOST Copy Member Pop-up Number 1

L mmm o mmm o oo e e . 11 ===» CER
Generate - HOST Copy Member 1 0F 2

Enter ned COPY member information. Press Enter when

complete,
= Existing Copybock Infarmaticn
* Cgpg Mamber . e . . s EMEE AN KN EX S
Data Wame ., . . . . . . . : DFHCOMHRREA

hMeu Copubook Infarmation
Copy Member . . . . . . CPYCOMAR _
Starting Level Mumber 5
Level Humber Increment 5

Accept the new copy member defaults, or change the name and level numbers, and
press Enter to display the Generate - HOST Server Module pop-up (see Figure 45 on

page 52).

Figure 44 + Generate - HOST Copy Member Pop-up - Number 2

[ et .11 ===% CER
Generate - HOST Copy Member 2 0OF 2

Enter ned COPY member information. Press Enter when
complete.

Existing Copybocok Infarmation
* Capy Memker . . . . . . . : WIRRERHC EEEE LS £ St
Data Hame . . . . . . . . : BROWSED

hew Copybock Infarmation
Copy Member . .
Starting Level Number
Level Humber Increment

IRAERCSE

o=

51



ASG-Encore Installation Guide

5  Type 1 to select Generate options, as shown in Figure 45, and press Enter to display
the Options - Generate pop-up (see Figure 46).

Figure 45 » Generate - HOST Server Module Pop-up

Generate - Select Logic Segment

Lo mmmmmmmmmm oo mm oo |1 ===} CER
Gz=nerate - HOST Copy Member
E|  Generate - HOST Server Womte
- © Type Frogram ID and select generatian aptiens. | -----------
f Objective . . : Client Serwver EEEEMER RS

Program ID . . . SERYER

Functions

1I_ 1. Generate options...
2, Generate COPY members...
9. Generate server module
q. Exit

6 Indicate the options you want for the COBOL Module generation and press Enter.
Press PF3 to return to the Generate - HOST Server Module pop-up (see Figure 47 on

page 53).

Figure 46 » Options - Generate Pop-up

Generate - Zelect Loglc Segment
L mmmmmmmmmmmmm e m oo -—-——-—- 1] ===} C5R
Generate - HOST Copy Hembar

E Generate - HOET Serwver Module

e | e m e
- Dptians - Generate
=
® Zelect the desired COBOL Module Generate QOptions.

£ Display EDIT dptions Output te Existing Library

LOEJL Source
Fult DATA DIWISION _ Retain Source Lime Numbers
Retain COPY statements _ Retain PERFORMed Paragraphs
In-line Communication Area
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2 Customization

7  Type 2 to select Generate COPY members, as shown in Figure 47, and press Enter
to display the Generate - COPY Members pop-up (see Figure 48).

Figure 47 » Generate - HOST Server Module Pop-up

T e T EE . 11 ===3 CBR

E Geperate - HOST Server Module
- ° Type Program ID and =s=lect generation options. | -----------
f Objective . . @ Client Server EELEEEIE YT
Program ID . . . SERYER
Functians

Z_ 1. Germerate optians...
Generate COPY members. ..
Generate server medule
Exit

Lo ko

8  Type S next to the COPY member you want to select and press Enter to display the
Edit screen (see Figure 49 on page 54).

Figure 48 + Generate - COPY Members Pop-up

Generate = COPY Hembers
Command ===7 Scroll === CER

Select the CORY Members to be generated and press Enter. Pracss FF3s161END)
when all selections are complete,

5 - Select

COPY Hember Comtents Cenerated
5 CPYCOMAR BFHCOMHRRER Ha

YIARBRCS BROMSED HO

EREEARE KA REERT RN NTREEME A KAMEL EOTTOM OF DATH SEfXss xs¥¥FEFREFEFREF XTI RERRT
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9  Type CREATE on the command line and C 9999 on the first line of code, as shown

in Figure 49. Press Enter to display the Edit/View - Create pop-up to save the module
in your source library (see Figure 50).

Figure 49 » Edit Screen

ASG-Encore EDIT - VWIASHG. ENCOBA3E. COBOL COLUMMHS 20281 a7z

Command ===: CREATE Scroll ===: CER
Top of Lata

C 9999 _ 05 RESPOMSE FIC S908) COMP.

QEoEE2 05 ASG-DFHCOMM.

QooaE3 #* ASG-EMCORE - DFHCOMMAREA

CIDGEE 4 *

QEOEES 18 STATS FPIC H(1).

CIEAEEE in RIDE FIC QlR).

QEoEET 1o RIDF FPIC 9G],

GIDOEEE 05 ASG-DFHEIEYARS.

QEOEES 10 ASG-EIBALD FIC X(1).

Bottom of Data

| ASGIED2I EMTER THE CREATE COMMAMD TO SAYE THE COBOL PROGRAM. |

10 Type the name you want to save the member under in your source library, clear any
data in the Data Set Name and Volume Serial fields, and press Enter to return to the
Edit screen (see Figure 51 on page 55).

Figure 50  Edit/View - Create Pop-up

Edit/WView - Create
Command ===3

"Current” Data 3et: USERID.ENCO0033.COBOL

To ISPF Library:

Project . . . A5G
Group . . . . CEGO0XEEX
Type . . . . CNTL
Member . . . CPYCOMAR

To Other Partitioned Data et Member:
Data 3et Name .
Volume Serial . . . [If not cataloged)
Data 5Set Password . . [If password protected)

Enter "/ to select option
Specify pack option for "CREATE™ Data Set

Press ENTER key to create. Enter END command to cancel create.




2 Customization

The Edit screen redisplays with a message in the upper right corner of the screen
confirming that the member has been created, as shown in Figure 51. Press PF3 to
return to the Generate - Copy Members pop-up (see Figure 52 on page 56).

Figure 51 « Edit Screen

ASG-Encore EDIT - VWIASHG. ENMCOSO3E. COBOL Membuzr CRTYCOMAR created

Command === Scroll ===: CER
Top of Lata

GIDEEE 1 05 RESPOMSE FIC S908) COMP.

QEoEE2 05 ASG-DFHCOMM.

QooaE3 #* ASG-EMCORE - DFHCOMMAREA

CIDGEE 4 *

QEOEES 18 STATS FPIC H(1).

CIEAEEE in RIDE FIC QlR).

QEoEET 1o RIDF FPIC 9G],

GIDOEEE 05 ASG-DFHEIEYARS.

QEOEES 10 ASG-EIBALD FIC X(1).

Bottom of Data
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A confirmation message displays in the long message area indicating that the
COBOL module generated successfully, as shown in Figure 52. The status also
changes from NO to YES under the Generated column. Select the next Copy
member and repeat step 8 on page 53 through step 11 on page 55 to edit and save

the member.

Figure 52 « Generate - COPY Members Pop-up

Gerierate - COPY Members
Command ===

when all selections are complete,
S - Select
COPYT Member Contents

—  CPYCOMAR  DFHCOMMAREA
5 MIARBRCS — BROWSEOQ

EOTTOM OF DATA

Select the COPYT Members to be generated and press Enter.

Scroll ===} CSR
Press PF3<1SCEHD]

Generat ed

ASG43231 COBOL MODULE SUCCESSFULLY GEMERATED. |

12  Once saved, press Enter and then PF3 to return to the Generate - COPY Member

pop-up.




2 Customization

After the member has been saved and you return to the Generate - COPY Members
pop-up, a message displays in the long message area indicating that the COBOL
module generated successfully, as shown in Figure 53. The status also changes
from NO to YES under the Generated column.

Figure 53 « Generate - COPY Members Pop-up

Gererate - COPY Members
Command === Scroll ===: CSR

Select the COPYT Members to be generated and press Enter. Press FFa-15(EHD)
when all selections are complete,

S - Select

COPY Membetr Contents Gererated
CPTCOMAR  DFHCOMMAREA TES
YIARBRCS — BROWSEQ TES

BOTTOM OF DATA

ASG42231 COBOL MODULE SUCCESSFULLY GEMERATED. |

13  Press PF3 to return to the Generate - HOST Server Module pop-up (see Figure 54 on
page 58).
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14 Type 3 to select Generate server module, as shown in Figure 54 and press Enter to
display the Edit screen (see Figure 55).

Figure 54 » Generate - HOST Server Module Pop-up

E Generate - HOST Server Module
- ASG43291 COBOL MODULE SUCCESSFULLY GENERATED. | =-----------

* Objective . . : Client Server KKK KK KKK KK K
Program ID . . . SERVER

Functions

3_ 1. Generate options...
2. Generate COPY members...
3. Generate server module
4. Exit

15 Type CREATE on the command line and C 9999 on the first line of code. Press
Enter to display the Edit/View - Create pop-up to save the module in your source
library (see Figure 56 on page 59).

Figure 55+ Edit Screen

ASG-Encore EDIT - VIASHG. EMCOSO44. COBOL COLUMMHS 20281 a7z
Command ===> CREATE Scroll === CSR
Top of Cata

C 9999
DRz
CIDEEE3
GIDCEES
GIDDEES
CIEAEEE
oRooaT
elnfaelats)
DR
GIEAE1G
oooall
QEoEL 2
jololoich e
GIEEE1 4
QooaLs
GE0ELE
QEoaLT
GIDEE L

GIDOEL ASGIED2I EMTER THE CREATE COMMAMD TO SAYE THE COBOL PROGRAM.
[ololoche]

GEnE21

ASG, IMC.

GEMERATED BV ASG-EMCORE RELEASE E.00Q0E7
FROGRAM: SERVER
LATE: CO-MEM-TY7T HHIFM: 5SS
REQUESTOR: USERID
AKR IMFORMATION

LS MAME: USERID.PART.AKR

MEMEER: W IARERWE ALIAS: C(MOME)
SEGMEMT MAME: CLIENMT-SERVER-DOO1L

EEEFELETFEEL XX EE R
¥ EEEFEEEEEEEREEEE

CBJECTIVE TYFE: CLIENT SERVER
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2 Customization

Type the name you want to save the member under in your source library, as shown
in Figure 56, clear any data in the Data Set Name and Volume Serial fields, and press

Enter to return to the Edit screen (see Figure 57).

Figure 56 « Edit/View - Create Pop-up

Meru RefLizt Utilities Help

Edit-Yiew - Create
Command ===

"Current” Data Set: VIASHG.EEMCOOO44. COBOL
To ISFF Library:

Froject . . . USER
Group . . . . TEST
Type CHTL
Member SERVER,

To Other Partitioned Data Set Hember:
Lata Set Mame . .

Wolume Serial . . . [If not cataloged)
Data Set Password . . [If password protected)

Enter "-" to select cption
Specify pack option for "CREATE" Data Set

Fress EMTER key to create. Enter EWD command to cancel create.

The Edit screen redisplays with a message confirming that the member has been
created. Press PF3 to return to the Generate - HOST Server Module pop-up (see

Figure 58 on page 60).

Figure 57 « Edit Screen

ASG-Encore EDIT - VWIASHG. ENCOAA44. COBOL Member SERVER created
Command === Scroll ===: CSR
Top of Lata
GIDEEE 1
QEoaEz * ASG, IMC. #
GIDEEE3 # *
QIDGEE4 + GEMERATED BT ASG-EMCORE RELEASE E.8(E@E]) *
QEOEES * *
QOOAEE + PROGRAM: SERVER *
GIDOEET * *
QEOEEE # DATE: CO-MEM-T7TT HH:IMM: 55 *
QEAEES #+ REQUESTOR: USERID #
[ ]alaleFRe] # *
GIDOEL L # AKR IMFORMATION *
QEoE1z # DS HMAME: UZERID. PART.AKR *
QEoE1E * MEMBER: Y IARERWS ALIAS: CHOME) #
GIDOEL 4 # *
QEOaLS # SEGMEMT MAME: CLIEMT-SERNMER-2EG1 *
QEOE1E * *
QooaLy # OBJECTIVE TYPE: CLIEMT SERVER *
GEOELE ICEMTIFICATION DIVISION.
QEaE1a FROGRAM-I0. SERVER.
QEAEZ0 EMMIROMMENT DIVISION.
[ lalalzhes)
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18 Type 4 and press Enter to exit the Generate - HOST Server Module pop-up, as

shown in Figure 58, and return to the Encore Primary screen.

Figure 58 « Generate - HOST Server Module Pop-up

Generate - Select Logic Segment

Generate - HOST Copy Member

L

m

Gererate - HIST Serwver Module

[}

- Type Program ID and select generation options.

*

Objective . . @ Client Serwver
Program Il . . . SERYER

Functians

- 1. Gernerate options...
Gerer-ate COPT members...
Gererate serwer module
Exit

Fo G B2

ASG43291 COBOL MODULE SUCCESSFULLY GEMERATED.

===k L[5SR

RE S S s o E

The customization and verification of Encore is complete.




Glossary

Abend
Abnormal end of task.

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter.

AKR (Application Knowledge Repository)
A BDAM or VSAM file that contains all analysis information produced by the analyze
function of the Application Analytical Engine.

AKR utility log
File that provides a summary of the commands issued to the Batch AKR Utility.

Alias Of

A field on a pop-up listing entries in the AKR. If the analyzed program contains an Entry
point, Alias Of is the name of the program that contains the Entry point. If the name in the
PROGRAM-ID statement was overridden at the time the analyze job was submitted,
Alias Of is the name that was entered in the AKR program name field on the

File - Analyze Submit pop-up.

analyze
The process by which Encore gathers information about the program, including program
relationships, logic, data and execution paths, and stores this information in the AKR.

analyze options

Run-time options that control the Analyze processing. Many of these options are similar
to the COBOL compiler options. Default values are established at installation time and
can be overridden by editing the Analyzer JCL or by using the analyze screens.

analyze summary report
A summary of the run-time statistics and diagnostic messages that are produced when an

analyze job completes.

anomalies
A deviation or departure from the normal Encore analysis process.
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Anomaly Repair facility

An Encore facility that allows you to repair programs already analyzed in an AKR that
contain anomalies. This is accomplished by allowing you to reanalyze the member that
generated the anomaly condition using the File » Anomaly facility pull-down option.

anomaly reports
Reports that contain information beneficial in understanding and diagnosing analysis
problems and anomalies.

anchor
An HTML element that defines a link between Internet resources.

API
Application programming interface. A set of calling conventions defining how a service
is invoked through a software package.

APPC

Advanced program-to-program communication. An implementation of the SNA LU 6.2
protocol that allows interconnected systems to communicate and share the processing of
programs.

application
Any group of programs that a user wants to analyze/view as a whole. These programs
would all be defined within the same application.

asynchronous
Without regular time relationship, unexpected or unpredictable with respect to the
execution of program instructions. See "synchronous" on page 72.

Batch AKR command
Control cards input in the VIASYSIN DD dataset of the Batch AKR Utility.

Batch AKR utility
The facility used to maintain the AKR without using ISPF.

browser
An application that displays World Wide Web documents.

business group
A logical grouping of applications by business function.

business rule
A logical business function that is performed by a COBOL program.

CERN
The Couseil Europeen pour la Recherche Nucleaire (European Particle Physics
Laboratory), which developed hypertext technologies.



Glossary

CICS server extract

A CICS server extract locates the necessary statements, files, and data elements required
to create a CICS Server Extract program. This program is then used to create a
COMMAREA-based server program from a CICS pseudo-conversational program.

client
As in client/server computing, the application that makes requests to the server and,
often, handles the interaction necessary with the user.

client/server computing

A form of distributed processing, in which the task required to be processed is
accomplished by a client portion that requests services and a server portion that fulfills
those requests. The client and server remain transparent to each other in terms of location
and platform. See client above and "server" on page 71 .

COBOL subset
COBOL verbs of a similar nature that have been grouped together. For example, READ,
WRITE, OPEN, and CLOSE are grouped into the IO subset.

command
An option in a menu. A command is selected to perform an action. There are the three
types of commands

e  Primary commands
e  Line commands

o Batch AKR utility commands

command input area
The field on Encore screens where primary commands are entered, indicated by ===> on
the fourth line of a screen, or the second line of a pop-up.

commit
An action that an application takes to make permanent the changes it has made to CICS
resources.

common code extract

The process of identifying the code that is common to two or more previously-extracted
Logic Segments. This includes all statements that appear in a selected Logic Segment, as
well as appearing in all other selected Logic Segments.

Common Gateway Interface (CGl)
The defined standard for the communications between HTTP servers and external
executable programs.

Common User Access (CUA)
A style of graphical interface that features screens, actions bars, pull-downs, and pop-ups
that are designed to provide easy access to all product features.
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complement extract

The process of identifying a set of COBOL statements that do not include a previous
extract. This includes all statements from the original program, excluding statements of
the previously-extracted Logic Segment, but retaining any statements needed by other
functional paths.

complement module

A complement module contains all statements from the original program, excluding
statements of the extracted Logic Segment, but retaining any statements needed by other
functional paths.

computation variable extract

The process of isolating the minimum set of statements that determine the value of a
particular data variable (known as the computation variable) at a particular statement in
the program.

cursor substitution character
A token substitution character that may be used in some primary commands. The cursor
substitution character is set on the Options - Product Parameters pop-up.

conversational

A communication model where two distributed applications exchange information by
way of a conversation. Typically, one application starts (or allocates) the conversation,
sends some data, and allows the other application to send some data. Both applications
continue in turn until one decides to finish (or deallocate). The conversational model is a
synchronous form of communication.

criteria
The information entered that was used to isolate a Logic Segment.

cursor position
The current location of the cursor on the screen, used as a starting point in certain
commands.

database

J A collection of interrelated data stored together with controlled redundancy
according to a scheme to serve one or more applications.

o All data files stored in the system.

J A set of data stored together and managed by a database management system.

dataname
A standard COBOL term for fields defined in the DATA DIVISION of a COBOL
program. Variable names, files, groups, array elements, and fully qualified datanames.
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data usage
Defines how a data item is used.

. DEF indicates the statements in the DATA DIVISION where the data item is
defined.

. USE indicates the statements where the value is used or tested.
. MOD indicates the statements where the value is set or modified.

o REF indicates any of the above conditions.

dead assignment

A statement that assigns a value to a variable, where the value is not referenced anywhere
in the source code. The assignment is not necessary and may be removed from the code
without affecting program execution.

delimiter
A character or sequence of characters used as a separator in text or data files.

Distributed Computing Environment (DCE)

Adopted by the computer industry as a de facto standard for distributed computing. DCE
allows computers from a variety of vendors to communicate transparently and share
resources such as computing power, files, printers, and other objects in the network.

distributed processing

An application or systems model in which function and data can be distributed across
multiple computing resources connected on a LAN or WAN. See "client/server
computing" on page 63.

Distributed Program Link (DPL)

Enables an application program executing in one CICS system to link (pass control) to a
program in a different CICS system. The linked-to program executes and returns a result
to the linking program. This process is equivalent to remote procedure calls (RPCs). You
can write applications that issue RPCs that can be received by members of the CICS
family.

Distributed Transaction Processing (DTP)

Enables a transaction running in one CICS system to communicate synchronously with
transactions running in other systems. The transactions are designed and coded
specifically to communicate with each other. This method is typically used by banks, for
example in just-in-time stock replacement.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese and Japanese that cannot be
represented with single byte codes.
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environment
The collective hardware and software configuration of a system.

equate
A substitution name for a character string.

External Call Interface (ECI)

An application programming interface (API) that enables a non-CICS client application
to call a CICS program as a subroutine. The client application communicates with the
server CICS program using a data area called COMMAREA.

External Presentation Interface (EPI)

An application programming interface (API) that allows a non-CICS application program
to appear to the CICS system as one or more standard 3270 terminals. The non-CICS
application can start CICS transactions and send and receive standard 3270 data streams
to those transactions.

File Transfer Protocol (FTP)
A protocol that defines how to transfer files from one computer to another.

forms
Parts of HTML documents that allow users to enter data.

function shipping

Enables an application program running in one CICS system to access resources owned
by another CICS system. In the resource-owning system, a transaction is initiated to
perform the necessary operation. For example, to access CICS files or temporary storage,
and to reply to the requester. The user is unaware of these behind-the-scenes activities,
and need not know where the resource actually exists.

gateway
Software that transfers data between normally incompatible applications, or between
networks.

gopher
Menu-based software for exploring Internet resources.

Graphic Interchange Format (GFI)
256-color graphic format.
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help
Encore provides these three levels of help:

o Long messages

o Notes

) Tutorial screens

Specific command information is available by entering a command, then pressing

PF01/13. The Help facility can also be accessed from the Help pull-down or any Encore
screen.

home page
The default page shown at the first connection to an HTTP server.

host

e  In a computer network a computer providing services such as computation,
database access, and network control functions.

o In a multiple computer installation, the primary or controlling computer.

hypertext
Text that activates connection to other documents when selected.

Hypertext Markup Language (HTML)
Standard language used to create hypertext documents.

Hypertext Transmission Protocol (HTTP)
Standard WWW client/server communications protocol.

Internet Keyed Payment Protocol (iKP)
Proposed protocol for conducting secure commercial financial transactions on the
Internet.

intercommunication

Communication between separate systems by means of Systems Network Architecture
(SNA), Transmission Control Protocol/Internet Protocol (TCP/IP), and Network Basic
Input/Output System (NetBIOS) networking facilities.

internet
A collection of networks.

label name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and
PROC literals. Label name specifies all transfers of control to a paragraph or section.

line command
An instruction entered in the line command area on certain screens.
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list box
A dialog box option containing a list of items the user can select.

list file
The file that is allocated when a request to print is issued.

live exit
An abnormality in program control caused by out of perform range GO TOs and
overlapping perform ranges.

log file
The file that is allocated by Encore and used for error messages and log commands. There
is a separate log file created by the Batch AKR utility.

logic segment

A set of source statements that is the result of a perform range extract, report extract,
computation variable extract, transaction extract, statement extract, complement extract,
server extract, or common code extract. The criteria used to isolate a Logic Segment may
be saved in the AKR.

logic segment complement
See "complement module" on page 64.

logical program unit
A PERFORMed range of code including GO TO code, or a CALLed program.

Logical Unit of Work (LUW)

An update that durably transforms a resource from one consistent state to another
consistent state. A sequence of processing actions (for example, database changes) that
must be completed before any of the individual actions can be regarded as committed.
When changes are committed (by successful completion of the LUW and recording of the
synch point on the system log), they do not need to be backed out after a subsequent error
within the task or region. The end of an LUW is marked in a transaction by a synch point
that is issued by either the user program or the CICS server, at the end of task. If there are
no user synch points, the entire task is an LUW.

long message

A diagnostic or error message that is displayed on line five of a screen or line three of a
pop-up. Long messages are sometimes preceded by short messages that are displayed in
the upper right corner of the screen. Pressing PFO1/PF13 (HELP) after receiving a short
message displays the corresponding long message.

LU type 6.2 (LU 6.2)

A type of logical unit used for CICS intersystem communication (ISC). LU 6.2
architecture supports CICS host-to-system-level products and CICS host-to-device-level
products. APPC is the protocol boundary of the LU 6.2 architecture.
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markup tag
Special character sequences put in text used to pass information to a tool, such as a
document formatter.

member
A member in a PDS or source manager such as Panvalet or Librarian. This can be the
alias name found in the AKR.

menu
A list of available commands in an application window. Menu names appear in the menu
bar of the application window.

menu bar
A bar that contains the menus available for your use.

message box
A box that displays a message (error or otherwise) to inform the user of a particular
condition.

Multipurpose Internet Mail Extension (MIME)
The Internet standard for mail that supports text, images, audio, and video.

NCSA Mosaic
A web browser available on multiple platforms.

online help
See "help" on page 67.

Online Transaction Processing (OLTP)

A style of computing that supports interactive applications in which requests submitted
by terminal users are processed as soon as they are received. Results are returned to the
requester in a relatively short period of time. An online transaction processing system
supervises the sharing of resources to allow efficient processing of multiple transactions
at the same time.

paragraph name
Any PROCEDURE DIVISION paragraph or section name, and the PROCEDURE and
PROC literals. Paragraph name includes the entire paragraph or section.

partial statement

In a generated COBOL module, a statement that has been modified to omit certain
datanames or file names that are not required for that statement in the generated module.
The partial statement contains only that portion of the statement required for the
generated module.
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perform range

A perform range consists of the source code contained in a PERFORM statement, and
includes all code that is or could be executed as a result of GO TOs, PERFORMs, etc.
within that PERFORM.

perform range extract

The process of isolating all executable statements of a perform range. This includes not
only the statements within the range, but also all code that is reachable using GO TO or
PERFORM from within the range.

pop-up

A window that appears as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to allow entry
of information for the requested action.

postscript
The standard for presenting text and graphics in a device-independent format.

primary command
An instruction entered in the command input area of the screen.

program
Program source member name, the name specified in the IDENTIFICATION DIVISION
of a COBOL program, or the CSECT name of a program that is not COBOL.

protocol
o A formal set of conventions governing the format and control of data.

e A set of procedures or rules for establishing and controlling transmissions from a
source device or process to a target device or process.

proxy
A gateway that allows Web browsers to pass on a network request (a URL) to an outside
agent.

pseudo conversational
A type of CICS application design that appears to the user as a continuous conversation,
but consists internally of multiple tasks.

pull-down

The list that appears when an action is selected on the action bar. On a pull-down, an
action followed by ellipses (...) displays a pop-up when selected and an action not
followed by ellipsis (...) immediately activates internal commands.

punch file
The file that is allocated when a request to punch is issued.
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recovery
The use of archived copies to reconstruct files, databases, or complete disk images after
they are lost or destroyed.

recoverable resources
Items whose integrity CICS maintains in the event of a system error. These include
individual files and queues.

recursion
A perform range or paragraph that performs itself.

re-engineering

The process of renovating an existing program to isolate and extract distinct functions.
Encore can isolate and extract code based on a perform range, report, computation
variable, transaction, or server.

report extract

The process of isolating all WRITE/GENERATE statements for a specific File
Description (FD) or Report Description (RD). Individual statements may be selected. The
extracted unit consists of the statements required to produce the WRITE/GENERATE
statement(s).

SBCS
See "Single Byte Character Set - (SBCS)" on page 72.

screen
A full-width display of information containing an action bar as the first line. Encore
screens are modeled after TSO/ISPF screens.

screen subset
The result of an interactive command.

script
An executable program invoked by HTTP servers.

script file
A dataset containing Encore commands, created when SET SCRIPT is ON, and executed
with the EXECUTE primary command or the File » Execute script pull-down option.

server

Any computing resource dedicated to responding to client requests. Servers can be linked
to clients through LANs and WANS to perform services (such as printing, database
access, fax, and image processing) on behalf of multiple clients at the same time.

server extract

Process used to create a COMMAREA-based server program from a 3270 CICS
pseudo-conversational program.
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shortcut key
A keyboard key or combination of keys that invokes a particular command, such as
CNTL + N.

short message

A diagnostic or error message that is displayed in the upper right corner of Encore
screens. Pressing PF1/PF13 (HELP) after receiving a short message displays the
corresponding long message.

Single Byte Character Set - (SBCS)

A character set that uses one byte to represent each character. Single Byte Character Sets
are used with languages, such as English, where the characters can be represented with a
one-byte code.

Socket Secure (SOCKS)
The gateway that allows compliant client code (client code made socket secure) to
establish a session with a remote host.

Standard Generalized Markup Language (SGML)
The standard that defines several markup languages, HTML included.

statement extract
The process of isolating all user-identified statements from a program.

status bar
The area at the bottom of a main window that lists the status of an action and gives other
information, such as the meaning of a command.

Storage Management Subsystem (SMS)

An operating environment that automates and centralizes the management of storage. To
manage storage, SMS provides the storage administrator with control over data class,
storage class, management class, storage group, and ACS routine definitions.

subset
A grouping of source lines in a program. See "COBOL subset" on page 63, "screen
subset" on page 71, and "tagged line subset" on page 73 .

synchronous

o Pertaining to two or more processes that depend on the occurrence of a specific
event such as a common timing signal.

J Occurring with a regular or predictable time relationship.



Glossary

synchpoint

A logical point in execution of an application program where the changes made to the
databases by the program are consistent and complete and can be committed to the
database. The output, which has been held up to that point, is sent to its destination. The
input is removed from the message queues and the database updates are made available to
other applications. When a program terminates abnormally, CICS recovery and restart
facilities do not back out updates prior to the last completed synchpoint.

tagged line subset
Command results displayed in columns 73 through 80 of the Source View screen.

target
The object of a primary command.

transaction

A unit of processing (consisting of one or more application programs) initiated by a
single request. A transaction can require the initiation of one or more tasks for its
execution.

transaction extract

The process of isolating all conditional statements for a specific transaction control
variable. Certain program paths may then be selected or blocked, based on the transaction
code value.

transaction processing

A style of computing that supports interactive applications in which requests submitted
by users are processed as soon as they are received. Results are returned to the requester
in a relatively short period of time. A transaction processing system supervises the
sharing of resources for processing multiple transactions at the same time.

transaction routing

Enables a terminal connected to one CICS system to run a transaction in another CICS
system. It is common for CICS/ESA, CICS/VSE, and CICS/MVS users to have a
terminal-owning region (TOR) that owns end-user network resources.

VIASUB
An edit macro included with Encore that is used to submit an Analyze job.

VIASUBDS
A CLIST included with Encore that is used to submit an Analyze job.
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view method
The manner in which a program is examined in the View facility. These are the three
view methods based on source code:

. Structure view
. Tree view

. Source view
All three views are available concurrently when a program is examined.

work file
A temporary file allocated upon entry to Encore.
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Encore CNTL and CLIST Members

Encore CNTL Members

This table contains Encore CNTL members.

Member Description

VIA$SPRMA The Encore specific default installation options.

VIASRLSA Backup of VIASPRMA.

VIARANOM COBOL demonstration program source for anomaly reporting and
repair.

VIARCBSK Generated module header box template.

VIAACMPI1 JCL to compile and analyze VIARDEMO demonstration program.

VIAACMP2 JCL to compile and analyze VIARDRIV and VIARSVBR
demonstration programs.

VIAACMP3 JCL to compile and analyze VIARANOM demonstration
programs.

VIAACMP4 JCL to compile and analyze VIARBRWS demonstration programs.

VIARBRWC Copybook for CICS demonstration program source.

VIARBRWS CICS demonstration program source.

VIARBRW Map for CICS demonstration program Main menu panel.

VIARCPY1 COBOL demonstration program copy member.

VIARCPY?2 COBOL demonstration program copy member.

VIARCSFP Description of COBOL/SF library+ allocations.
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Member Description

VIARDEMO COBOL demonstration program source.

VIARDRIV COBOL demonstration program source.

VIARIOBK PARM block used to communicate with an IO module.

VIARIOFC 10 module function code constants.
VIARIOSK Generated COBOL program template.
VIARMNU Map for CICS demonstration program Browse menu panel.

VIARMNUC Copybook for CICS demonstration program Browse menu panel.

VIARNTSK Generated COBOL program message template.

VIARSUBR COBOL demonstration program source.

Encore CLIST Members

This table contains Encore CLIST members.

Member Description

ENCORE Invokes the Encore product from the ISPF panel.
VIAACSF Invokes the COBOL/SF ECFSTART command.
VIAACSFI CLIST for COBOL/SF to Encore interface.
VIACSTM CLIST for customizing Encore.

VIAENC Invokes the Encore product.

VIAATEST CLIST to establish a TSO test session with Encore.
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A
AKR, allocation 18
Alliance
accessing from ESW screen ix
description vi
linking ix
Anomaly Repair Facility
online panel-driven example 41
parameter-driven example 40
Anomaly Repair Facility parameters
ANOMALY 21
COMMENT 21
DSN 22
GTD 21
HEADER 22
IPR 21
MEM 22
OOPGT 21
PARM 21
VIAANOMF 21
anomaly report parameters
NUMPRMA (##) 21
RPTCEN 21
VIARERPT 21
VIARERPTAN 21
AutoChange
accessing from ESW screen ix
description vi

B

Bridge
accessing from ESW screen ix
description vi

C

CENTER parameter 8, 11-12
Center, description vi
CICS parameter 9
CICS server
CICS EXEC 46
CICS server endpoints 46
CICS server paths 48

CICS server startpoints 47
copy member field 51
CREATE command 54
endpoints 45
level number increment 51
self-directed server name 45
starting level number 51
statement extract 49

CICS server extract 63

CICS server extract - CICS statements 48

CICS server extract - EXEC CICS SEND 48

CICS server extracts 4

CICSCOB parameter 9

CICSLIB parameter 9

CICSTRAN parameter 9

CLIST member
ENCORE 14,76
VIAACSF 76
VIAACSFI 76
VIAATEST 76
VIACSTM 76
VIAENC 76

CNTL member
VIA$PRMA 13,75
VIASRLSA 75
VIAACMPI 21,75
VIAACMP2 21,75
VIAACMP3 21,75
VIAACMP4 21,75
VIAACSF 13
VIARANOM 75
VIARBRW 75
VIARBRWC 75
VIARBRWS 75
VIARCBSK 13,75
VIARCPY1 75
VIARCPY?2 75
VIARCSFP 13,75
VIARDEMO 76
VIARDRIV 76
VIARIOBK 76
VIARIOFC 76
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VIARIOSK 76
VIARNTSK 76
VIARSUBR 76
VIASLPAJ 10
VIASLPXIJ 10
COBCOMP parameter 8
COBOL 5
COBOL/SF, interfacing with Encore 13
common code extract 63
compile and link JCL
VIARANOM program 21
VIARBRWS program 21
VIARDEMO program 21
VIARDRIV program 21
VIARSUBR program 21
compilers
COBOLD,E,and F 5
COBOL for MVS and VM 5
COBOL for 0OS/390 and VM 5
COBOLII 5
COBOL/370 5
Object Oriented conditions not
supported 5
COMPILR parameter 8
complement extract 64
computation variable extract 64
conventions page Xii
customizing, module header template 13

D

DB?2, validation 40

demonstration programs
VIARANOM 8§
VIARBRWS 8§
VIARDEMO 8§
VIARDRIV 8
VIARSUBR 8

E
Encore
accessing from ESW screen ix
description vii
functional components 2
invoking from ISPF 14
invoking with CLIST 14
invoking with TSO VIAENC
CLIST 14
migration 4
ENCORE CLIST member 14, 76
Encore installation
CENTER parameter 8
CICS parameter 9
CICSCOB parameter 9

CICSLIB parameter 9
CICSTRAN parameter 9
CNTL member VIAACMP1 §
CNTL member VIAACMP2 §
CNTL member VIAACMP3 8§
CNTL member VIAACMP4 8§
CNTL member VIARCSFP 13
CNTL members to modify and
execute 8
COBCOMP parameter 8
COBOL/SF interface set up 13
COMPILR parameter 8
NEWAPPL 14
SYSDA parameter 8
SYSOUT parameter 8
TRNPARM parameter 9
UNIQUE 19
validating parameter definitions 16
validation 15
VIA$SPRMA COBOLSEF option 9
VIA$PRMA export option 9
VIASPRMA
Gen-COBOL-Last-Node=
option 9
VIA$SPRMA modification 9
VIA$PRMA NETRON option 9
VIAACMP3 parameters 9
VIAACMP4 parameters 9
VIAACSF CLIST member 13
VIASOFT parameter 8
environment
client - Windows 95/98/2000 5
client - Windows NT with access to
MVS 5
host - 3270 type terminals 5
host - BATCH region size 5
host - Direct Access storage 5
host - MVS ISPF 5
host - MVS/XA, MVS/ESA, or
0S/390 5
host - TSO logon region size 5
host - VSAM 5
platform and software requirements 5
server - OS/390 5
Estimate
accessing from ESW screen ix
description vii
ESW
description v
invoking products viii
product integration ix

|
IDMS, validation 39
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accessing from ESW screen ix
description vii
using analysis functions ix
working with 25
installation prerequisites, Center 7
ISPF
adding Encore 14
menu option 14

L

Librarian customization
ASMBLR parameter 12
CENTER parameter 12
customized edit panel 12
ISPLLIB 12
LIBDEF 12
LIBDEF facility 12
LIBRLIB parameter 12
LIBRMAC parameter 12
load library 12
SYSDA parameter 12
SYSOUT parameter 12
VIALLIB 12
VIASFAIIM module 12
VIASFAIR member 12
VIASFAIR module 12
VIASOFT parameter 12
VSPEDLIB panel 12
WTP messages 12

M

menu option, ISPF 14

MLPA
adding Encore modules 10
improving performance 10
staging library 10
VIAENC module addition 10
VIARCMMP module addition 10
VIARCSFI module addition 10
VIARCSFM module addition 10
VIARCSOM module addition 10
VIARICSF module addition 10
VIARISPP module addition 10
VIARWKSP module addition 10
VIASLPXJ CNTL member 10
VIAZBTCH module addition 10
VIAZCMDP module addition 10
VIAZGENP module addition 10
VIAZPRIP module addition 10
VIAZTBLP module addition 10

MPLA, VIASLPAJ CNTL member 10

Index

N
NEWAPPL parameter 14

(o)

overview, target generation 4

P

Panvalet customization
ASMBLR parameter 11
CENTER parameter 11
customized edit panel 11
ISPLLIB 11
LIBDEF 11
LIBDEF facility 11
load library 11
PANLIB parameter 11
SYSDA parameter 11
SYSOUT parameter 11
VIALLIB 11
VIASOFT parameter 11
VIASPAM module 11
VIASPAMJ CNTL member 11
VSPEDPAN panel 11
WTP messages 11

parameter, UNIQUE 19

perform range extract 70

PLPA
adding Encore modules 10
improving performance 10
staging library 10
VIAENC module addition 10
VIARCMMP module addition 10
VIARCSFI module addition 10
VIARCSFM module addition 10
VIARCSOM module addition 10
VIARICSF module addition 10
VIARISPP module addition 10
VIARWKSP module addition 10
VIASLPAJ CNTL member 10
VIASLPXJ CNTL member 10
VIAZBTCH module addition 10
VIAZCMDP module addition 10
VIAZGENP module addition 10
VIAZPRIP module addition 10
VIAZTBLP module addition 10

preprocessor support
command level CICS 6
command level DL/ 6
IDMS 6
other preprocessed languages 6
SQL 6

product integration ix

PTFs, applying maintenance 10
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R
Recap
accessing from ESW screen ix
description vii
report extract
description 71
extracting the objective 44

S

server extract 71

SmartDoc
accessing from ESW screen ix
description vii

SmartEdit
accessing from ESW screen ix
description viii

SmartTest
accessing from ESW screen ix
description viii

statement extract 72

SYSDA parameter 8

SYSOUT parameter 8

T
target generation, overview 4

transaction extract 73
TRNPARM parameter 9

)
UNIQUE parameter 19

\"/
VIA$SPRMA CNTL member 75
VIASRLSA CNTL member 75
VIAACMP1 CNTL member 8, 21, 75
VIAACMP2 CNTL member 8, 21, 75
VIAACMP3 CNTL member 8, 21, 75
VIAACMP4 CNTL member 8,21, 75
VIAACSF CLIST member 76
VIAACSF CNTL member 13
VIAACSFI CLIST member 76
VIAATEST CLIST member 76
VIACSTM CLIST member 76
VIAENC CLIST member 14,76
VIARANOM CNTL member 75
VIARANOM demonstration program 8
VIARBRW CNTL member 75
VIARBRWC CNTL member 75
VIARBRWS CICS demonstration
program 8
VIARBRWS CNTL member 75
VIARCBSK CNTL member 75
VIARCPY1 CNTL member 75

VIARCPY2 CNTL member 75
VIARCSFP CNTL member 13, 75
VIARDEMO CNTL member 76
VIARDEMO demonstration program 8
VIARDRIV CNTL member 76
VIARDRIV demonstration program 8
VIARIOBK CNTL member 76
VIARIOFC CNTL member 76
VIARIOSK CNTL member 76
VIARNTSK CNTL member 76
VIARSUBR CNTL member 76
VIARSUBR demonstration program 8
VIASFAIR module 12

VIASLPAJ CNTL member 10
VIASLPXJ CNTL member 10
VIASOFT parameter 8
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